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1
Agency Information

Label Locations

Dolphin 7850 mobile computers meet or exceed the requirements of all applicable standards organizations for safe operation. 
However, as with any electrical equipment, the best way to ensure safe operation is to operate them according to the agency 
guidelines that follow. Please read these guidelines carefully before using your Dolphin mobile computer. 

Dolphin 7850 Series 802.11g (WLAN) & Bluetooth

Dolphin 7850 RF terminals are designed to comply with the most current applicable standards on safe levels of RF energy 
developed by the Institute of Electrical and Electronics Engineers (IEEE) and the American National Standards Institute (ANSI) 
and has been recommended for adoption by the Federal Communications Commission (FCC). 

Laser Safety Label
If the following label is attached to your product, it indicates the product contains a laser 
engine or laser aimer: 

Laser Eye Safety Statement: This device has been tested in accordance with and 
complies with EN60825-1: 1993+A1+A2 and 21 CFR 1040.10 and 1040.11, except for 
deviations pursuant to Laser Notice No. 50, dated July 26, 2001. LASER LIGHT, DO NOT 
STARE INTO BEAM, CLASS 2 LASER PRODUCT, 1.0 mW MAX OUTPUT: 650nM. 

Caution - use of controls or adjustments or performance of procedures other than those 
specified herein may result in hazardous radiation exposure.

LED Safety Statement
This device has been tested in accordance with IEC60825-1 LED safety, and has been certified to be under the limits of a Class 
1 LED device.

The maximum power outputs for each diode are as follows:

• Illumination LED:  194.0 uW
• Aimer laser (5300 engine):  360.1 uW
• Aimer LED (5100 engine):  81.6 uW

Infrared LED Safety Statement
Caution - Class 1M LED radiation when open. Do not view directly with optical instruments. 

The maximum power outputs for the IR LED is 145.1 uW.

UL and cUL Statement

UL and cUL listed: UL60950-1 and CSA C22.2 No. 60950-1-03.

Laser Safety Label

Laser Safety Label

LASER LIGHT. DO NOT STARE INTO BEAM

1.0 mW MAX OUTPUT: 650nM
IEC60825-1:1993+A1+A2

CLASS 2 LASER PRODUCT

Complies with 21 CFR 1040.10 and 1040.1 1
except for deviations pursuant to Laser 
Notice No. 50, dated July 26, 2001.
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Regulatory and Safety Approvals for all Dolphin Terminals 

The CE Mark on the product indicates that the system has been tested to and conforms with the provisions noted within 
the 89/336/EEC Electromagnetic Compatibility Directive and the 73/23/EEC and 93/68/EEC Low Voltage Directive.

For further information, please contact:

Hand Held Products, Inc.
Nijverheidsweg 9
5627 BT Eindhoven
The Netherlands

Hand Held Products shall not be liable for use of our product with equipment (i.e., power supplies, personal computers, etc.) that 
is not CE marked and does not comply with the Low Voltage Directive.

Parameter Specification

U.S.A
Canada
European Community

FCC Part 15, Class B
ICES-003
EN 55022 (CISPR 22) Class B
EN60950:2000
EN60825-1:1994 + A11 + A2
EN55024:1998
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FCC Compliance 

Dolphin terminals comply with part 15 of the FCC rules. Operation is subject to the following two conditions: (1) this device may 
not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause 
undesired operation.

Dolphin RF Terminal—802.11g and/or Bluetooth
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not 
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause 
undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not 
occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the 
following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

If necessary, the user should consult the dealer or an experienced radio/television technician for additional suggestions. The user 
may find the following booklet helpful: “Something About Interference.” This is available at FCC local regional offices. Our 
company is not responsible for any radio or television interference caused by unauthorized modifications of this equipment or the 
substitution or attachment of connecting cables and equipment other than those specified by our company. The correction is the 
responsibility of the user. Use only shielded data cables with this system.

In accordance with FCC 15.21, changes or modifications not expressly approved by Hand Held Products, Inc. may void the FCC 
authorization to operate the equipment.

CAUTION! Any changes or modifications not expressly approved by the grantee of this device could void the user's authority 
to operate the equipment.

For body worn operation, this device has been tested and meets the FCC RF exposure guidelines when used with the Hand Held 
Products Dolphin accessories supplied or designated for this product. Use of other accessories may not ensure compliance with 
FCC RF exposure guidelines.

RF, Regulatory, and Safety Agency Approvals—802.11g and/or Bluetooth 

R&TTE Compliance Statement—802.11g and/or Bluetooth
Dolphin RF terminals are in conformity with all essential requirements of the R&TTE Directive (1999/5/EC). This equipment has 
been assessed to the following standards as applicable: 

Parameter Specification

RF Approvals
U.S.A
Canada

FCC Part 15.247
RSS 210 

Parameter Specification

R&TTE EN 300 328-2:2000
EN 301 489-1 (2002-08)
EN 301 489-17 (2002-08)
EN 60950:2000
EN 50361:2001
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This product is marked with  in accordance with the Class II product requirements specified in the R&TTE 
Directive, 1999/5/EC.

The equipment is intended for use throughout the European Community. PAN European Frequency Range: 2.402—2.480 GHz.

Restrictions in France are as follows: 

• Indoor use:  Maximum power (EIRP*) of 100 mW for the entire 2.400—2.4835 GHz 
• Outdoor use:  Maximum power (EIRP*) of 100 mW for the 2.400—2.454 GHz band and maximum power (EIRP*) of 10 mW 

for the 2.454—2.483 GHz band

Canadian Compliance

This Class B digital apparatus complies with Canadian ICES-003. Operation is subject to the following two conditions: (1) this 
device may not cause harmful interference, and (2) this device must accept any interference received, including interference that 
may cause undesired operation. 

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from windows to 
provide maximum shielding. Equipment (or its transmit antenna) installed outdoors is subject to licensing.

Cet appareil numérique de la Classe B est conforme à la norme NMB-003 du Canada.

For European Community Users

Hand Held Products complies with Directive 2002/69/EC OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL of 27 
January 2003 on waste electrical and electronic equipment (WEEE).

Waste Electrical and Electronic Equipment Information
This product has required the extraction and use of natural resources for its production. It may contain hazardous substances 
that could impact health and the environment, if not properly disposed.

In order to avoid the dissemination of those substances in our environment and to diminish the pressure on the natural resources, 
we encourage you to use the appropriate take-back systems for product disposal. Those systems will reuse or recycle most of 
the materials of the product you are disposing in a sound way.

The crossed out wheeled bin symbol informs you that the product should not be disposed of along with municipal waste 
and invites you to use the appropriate separate take-back systems for product disposal.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste 
administration.

You may also contact your supplier for more information on the environmental performances of this product.

Pacemakers, Hearing Aids and Other Electrically Powered Devices

Most manufacturers of medical devices adhere to the IEC 601-1-2 standard. This standard requires devices to operate properly 
in an EM Field with a strength of 3V/m over a frequency range of 26 to 1000MHz. The maximum allowable field strength emitted 
by the Dolphin is 0.3V/m according to Subpart B of Part 1 of the FCC rules. Therefore, the Dolphin RF has no effect on medical 
devices that meet the IEC specification. 

Microwaves

The radio in the Dolphin RF terminal operates on the same frequency band as a microwave oven. Therefore, if you use a 
microwave within range of the Dolphin RF terminal you may notice performance degradation in your wireless network. However, 
both your microwave and your wireless network will continue to function. The Dolphin Batch terminal does not contain a radio, 
and therefore, is not affected by microwave ovens.
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2
Getting Started

This chapter describes what to do with your Dolphin device when you first receive it.

Step 1. Unpack the Carton
Verify that the carton contains the following items: 
• Dolphin 7850 mobile computer (the terminal)
• Main battery pack (7.4v, Li-ion)
• Getting Started CD-ROM
• Dolphin 7850 Quick Start Guide

Be sure to keep the original packaging in the event that the Dolphin terminal should need to be returned for service. For details, 
see Limited Warranty on page 13-3. 

If you ordered additional peripherals, accessories, verify that they are included with the order.

Step 2: Install the Main Battery Pack
Use only the Li-ion battery packs provided by Hand Held Products. The use of any battery pack not sold/manufactured by Hand Held Products 
in a Dolphin terminal will void your warranty and may result in damage to the Dolphin terminal or battery.

You must re-attach the battery door! The Dolphin 7850 contains a mechanical switch under the battery door that prevents the terminal from 
initializing unless the battery door is closed.

Step 3. Charge the Batteries
There are two types of battery power: the main battery pack and the backup battery located inside the terminal. The main battery 
pack powers the terminal and charges the internal backup battery. 

Dolphin terminals ship with both batteries discharged of power. Charge the main battery pack for a minimum of four hours 
before initial use! 

You can use one of the following charging peripherals:

• Dolphin HomeBase 
• Dolphin QuadCharger
• Dolphin Charge/Comm Cable
• Dolphin AC Adapter Cable

Step 4. Boot the Terminal
The terminal begins booting as soon as power is applied and runs by itself. Do NOT press any keys or interrupt the boot process.

When the boot process is complete, the Today screen appears and the terminal is ready for use.

!

Mechanical Switch

DC Power Jack

!

!
Use Dolphin 7850 peripherals with the power cables provided by Hand Held Products. Use of peripherals or cables not sold/manufactured by 
Hand Held Products will void the warranty and may damage the terminal.
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Today Screen

Initial boot and system resets end on the Today screen; see Resetting the Terminal on page 3-13. 

Note: You can also open the Today screen at any time by tapping Start > Today.

Navigation Bar

Located at the top of every screen, the Navigation bar provides access to the Start menu, shows the current time (from the system 
clock), and displays both status and keyboard status icons.  

Command Bar

Located at the bottom of application screens, the Command bar includes application menus, buttons, and provides access to the 
Soft Input Panel (SIP). 

The contents of the Command bar changes according to the open application.

Tap to adjust the volume

Tap to change the date and time

Tap to access the Start menu

These are icons of programs 
running in the background. Tap to 
open the program or access a 
menu for it. 

Tap to see to customize your terminal

Tap to open a program recently used

Tap to open a program

Tap to see additional programs

Navigation bar

Start menu

SIP
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Using the Stylus

Use the stylus or your finger to select or enter information on the touch panel. The stylus functions as a mouse; generally, a tap 
is the same as a click.

Tap Tap the touch panel once to open menu items and select options.

Drag Hold the stylus on the screen and drag across the screen to select text and images.

Tap & hold Tap and hold the stylus on an item and a pop-up menu appears. On the pop-up menu, tap the action 
of the task you want to perform.

Use of other objects, such as paper clips, pencils, or ink pens can damage the touch panel and will void the warranty. For 
more information about the touch panel, see Touch Panel Display on page 3-3.

Selecting Programs

The Start menu does not fit all installed programs. To see additional programs, tap Start > Programs. To open a program, tap 
once on the icon.

Pop-Up Menus

With pop-up menus, you can quickly choose an action for an item.  

1. Tap and hold the stylus on the item name. The pop-up menu appears.

2. Lift the stylus, and tap the action you want to perform. 

The contents of pop-up menus depend change according to the program you’re in.

Searching for Information

You can use the Search feature or File Explorer to find and organize information. Tap Start > Programs > Search. Enter the 
text you want to find and tap Search. 

!

Tap and hold to display
the pop-up menu.

Lift the stylus and tap
the action you want.

Tap outside the menu
to close it without performing
an action.

Note: To close the menu without 
performing an action, tap 
the screen anywhere 
outside the menu.

The Results section 
displays the search 
results.
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3
Hardware Overview

The Dolphin 7850 Series includes a number of standard terminal configurations as well as charging and communication 
peripherals and accessories to maximize the efficiency of your application setting.

Standard Terminal Configurations

The standard Dolphin 7850 terminal configuration is as follows:

• Microsoft Windows Mobile 5.0
• PXA270 520MHz processor
• 64MB RAM X 64MB Synchronous Flash
• 24-key calculator-style numeric with scrolling alpha or 38-key calculator-style numeric with full alpha
• 3.5 in. 1/4 VGA 240 x 320 TFT color display with hard-coat industrial touch panel
• 5300 or 5100 Standard Range (SR) image engine
• 802.11g radio (WLAN)
• Bluetooth radio

Configuration Options
The Dolphin 7850 Series offers you a number of configuration options to customize the Dolphin 7850 terminal to your business 
needs.

Memory Expansion Additional 64MB of RAM (for a total of 128MB RAM); see Memory on page 6-9.

Mass Storage Factory-installed 256MB or 512MB Secure Digital (SD) storage card.

Image Engines HP (High Performance) Laser scanner
LR (Long Range) Laser scanner
ALR (Advanced Long Range) Laser scanner
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Dolphin 7850 Series Peripherals 

The following items are sold separately to complete your Dolphin 7850 installation. 

Dolphin HomeBase™

The Dolphin HomeBase charging and communication cradle supports both RS-232 and USB communication, enabling your 
terminal to interface with the majority of PC-based enterprise systems. When a terminal is seated in the HomeBase, its main 
battery pack charges in less than four hours. 

For more information, see Dolphin HomeBase on page 10-1.

Dolphin QuadCharger™ 
The Dolphin QuadCharger is a four-slot charging station for Li-ion battery packs. It can charge each battery in less than four 
hours. The fourth slot features a battery analyzer that completely resets and re-calibrates a battery, then displays remaining 
capacity. 

For more information, see Dolphin QuadCharger on page 11-1. 

Dolphin Cables
The Dolphin 7850 Series includes a number of cable kits that enable you to charge and communicate with other devices. 

For more information, see Dolphin Cables on page 12-1.

Dolphin 7850 Series Accessories

Each of the following items is sold separately to enhance your Dolphin 7850.

Protective Enclosure
This enclosure wraps around the terminal to protect it from wear and tear.

Holsters
This enclosure holds one Dolphin 7850 terminal and can be worn around the waist for easy access.

Li-ion Battery Pack 
The 7.4Vdc, 14.8 watt hour Li-ion rechargeable battery pack provides the main power supply for Dolphin terminals.
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Front Panel Features

Decode and Scan LEDs

The Scan LED lights red when you press the Scan trigger in scanning applications.
The Decode LED lights green when a scanned bar code is successfully decoded.

For more information, see LEDs on page 4-1.

Keyboard Protection Ribs

These ribs protect the keyboard and prevent keys from being pressed accidentally when the terminal is placed 
facedown on a flat surface. For a complete overview of each keyboard, see Using the Keyboards on page 4-1.

Touch Panel Display

The 3.5 inch 1/4 VGA (Video Graphic Array) display is a 262-, 144-color, transflective LCD (Liquid Crystal Display) 
in TFT (Thin Film Transistor) color with a 240 x 320 resolution. The LCD is covered by an industrial touch screen 
lens for maximum durability and backlit for maximum viewability; see Backlight on page 6-7.

Hand Held Products recommends using a screen protector with the touch panel. Screen protectors help prevent 
wear and damage and also protect the touch panel; especially when used with applications that require high-volume 
interfacing with the touch panel. We expect users to replace the screen protector at regular intervals when the 
screen protector is becoming worn or punctured. 

For touch panel input, use the stylus included with the terminal or your finger. The method you choose depends on 
which one is most appropriate for your application. While there is a great deal of variation in different applications, 
use of the supplied stylus provides greater touch screen accuracy; see Using the Stylus on page 2-3.

Use of objects, such as paper clips, pencils, or ink pens on the touch screen can damage the touch panel 
and will void the warranty. 

Decode LED  Scan LED

3.5 inch 1/4 VGA Touch 
Panel Display

Keyboard Protection Ribs

!
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Back Panel Features

Battery Door

The battery door covers and secures the main battery pack in the battery well. There is a mechanical switch on the 
terminal under this door that puts the terminal in suspend mode (see page 3-13) while the battery door is open. This 
door must be closed for the terminal to resume operation. For more information, see Installing the Main Battery Pack 
on page 3-9.

DC Power Jack

Located on the bottom of the pistol-grip handle, the 9.5V DC power jack receives external power from the Dolphin 
Power Cable. When connected to the Dolphin Power Cable, the terminal is powered and the main battery pack is 
charging. For more information, see Using the Dolphin Power Cable on page 12-2.

Tether Holes

Loop one end of the optional battery door tether through these holes. For for information, see Battery Door Tether 
on page 3-6.

Battery Door DC Power Jack

Tether Holes
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Side Panel Features

Note: This graphic shows the right side of the Dolphin 7850 terminal.

Angled Touch Panel

The touch panel display (see page 3-3) tilts up toward the user, which helps prevent glare and increases viewability 
in low-light conditions. Most important, the tilted display helps you read decoded data without having to tilt your wrist 
up repeatedly.

Beeper

The beeper sounds during decoding to indicate a good or bad scan. 

Image Engine Window

The image engine reads and decodes most popular bar code 
symbologies; see Supported Bar Code Symbologies on page 5-2. 
In addition, the engine captures images like a digital camera. 

The image engine points straight out the image engine window; 
simply point and scan. There are several image engine 
configurations available; for details on each, see Available Image 
Engines on page 5-1.

Integrated Pistol-Grip

The pistol-grip handle is integrated into the terminal and is not removable, which makes the unit more durable in 
the field. The handle is also positioned so that the terminal is balanced in your hand for added comfort when using 
the unit over long periods of time. 

Scan 
Trigger

Stylus Slot

Integrated 
Pistol-Grip
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IrDA Port

The infrared port is IrDA-enabled (Infrared Data Association) and communicates with other IrDA-enabled devices 
such as PCs, printers, modems, or other Dolphin 7850 terminals. The maximum data transfer speed is 115 Kbps 
with a duty cycle of 18.75%. For more information, see Using Infrared Communication on page 7-8.

Scan Trigger

The front of the pistol-grip handle contains a scan trigger that activates the image engine. The scan trigger also 
wakes the terminal from Suspend Mode (see page 3-13).

Stylus Slot

Dolphin 7850 terminals ship with a stylus inserted into the pistol-grip handle. Stores the stylus in this slot when 
you’re not using it. For more information about the stylus, see Using the Stylus on page 2-3.

Fastener

This hole through the bottom of the pistol-grip handle is used as a fastener to attach certain hardware accessories 
to the terminal.

Stylus Tether

The optional stylus tether is a coiled elastic cord with two ends: one end hooks onto the end of the stylus and the 
other end loops through this fastener hole. This attaches the stylus to the terminal, which keeps you from losing the 
stylus if you accidently drop it. 

Battery Door Tether

The battery door tether loops through the stylus fastener hole on 
one end and loops through the two holes on the back of the battery 
door on the other end. The tether keeps the battery door attached 
to the terminal when the battery door is opened or removed from 
the back panel.
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Rubber Bumpers

There are two sets of rubber bumpers: one set below the image engine window and the other set on the bottom front of the pistol-
grip handle. Rubber bumpers enable you to set the terminal down on a flat surface with easy access to the handle, so you can 
pick up and put down the terminal with ease. 

Front Rubber Bumpers

The front rubber bumpers enable you to rest the terminal on a flat surface without damaging the image engine 
window.

Front Rubber 
Bumpers

Pistol-Grip 
Rubber Bumpers
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Bottom Panel Features

Mechanical Connector
The custom, industrial-grade, mechanical connector has 17 pins that are designed to work exclusively with Dolphin 7850 Series 
peripherals and cables. This connector powers the terminal, charges the main battery, and facilitates communication with a host 
workstation via Microsoft ActiveSync. The mechanical connector supports RS-232 (up to 115 Kbps) and USB (up to 12 Mbps). 

For more information about ActiveSync communication, see Using ActiveSync on page 7-3. 

The pins on the mechanical connector are as follows:

Note: Signals referenced are for a DTE device.

Mechanical 
Connector
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Battery Power

The Dolphin 7850 features intelligent battery technology with two types of battery power: 

• The main battery pack installed under the battery door on the back panel.
• The backup battery located inside the terminal.

Both batteries work together to prevent data loss when the terminal is used over long periods of time. 

Main Battery Pack
Use only the Li-ion battery packs provided by Hand Held Products. The use of any battery pack not sold/manufactured by Hand 
Held Products in a Dolphin terminal will void your warranty and may result in damage to the Dolphin terminal or battery.

The 7.4V, 14.8 watt hour Li-ion battery pack is the primary power source for the Dolphin terminal and the internal backup battery. 
The Li-ion battery is designed to operate in a temperature range of -10 to 50°C (14 to 122°F).

Installing the Main Battery Pack

Put the terminal in Suspend Mode (see page 3-13) before installing a new battery. Press Blue + Backlight keys.

The battery door contains a mechanical switch under the battery door that automatically suspends terminal operation while open. 
Because of this switch, the terminal will not resume normal operations until the battery door is closed.

Charging Options

When the battery is installed in the terminal, you can insert the terminal into any one of the following peripherals to charge the 
main battery pack:

• Dolphin HomeBase (see page 10-1)
• Dolphin ChargeBase (see page 15-1) 
• One of the Dolphin charging cables (see page 12-1)

To fully charge the Li-ion battery before installing it in the terminal, use the 

• Dolphin QuadCharger (see page 11-1)
• Auxiliary Battery Well of the Dolphin HomeBase (see page 10-3)

Charge Time

The Li-ion battery pack requires four hours to charge to full capacity.

!

!

Mechanical Switch
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Internal Backup Battery
Located inside the terminal, the backup battery is a 3.6V nickel metal hydride (NiMH) battery. 

The internal backup battery prevents the terminal from being reset when you remove the main battery pack. The backup battery 
retains RAM data and allows the real-time clock to remain operational for up to 30 minutes. If the terminal is left without the main 
battery pack for more than 30 minutes, the internal backup battery discharges and needs to be recharged to function according 
to specifications.  

Note: Even if the internal backup battery fails, data and programs stored in Flash memory are not totally lost, but the terminal 
does automatically cold boot when you install a fully charged battery pack and you need to reset the real-time clock.

Charging

The internal backup battery charges off the main battery pack and requires eight hours charge time to backup RAM data for 30 
minutes. You can begin using the Dolphin terminal after charging the main battery for four hours; however, the internal backup 
battery will continue to charge off the main battery. 

To ensure that the internal backup battery functions properly, maintain a consistent power supply for the first eight hours of 
terminal operation. This power supply can be external power (using a charging peripheral) or an installed, charged battery pack 
or a combination of both.

Guidelines 

Follow these guidelines to maximize the life of the Dolphin’s internal backup battery:

• Keep a charged Li-ion battery pack in the Dolphin terminal. 
• Keep the Dolphin terminal connected to a power source when the terminal is not in use. 

Managing Battery Power
Data and files saved on the Dolphin terminal may be stored in RAM memory; therefore, maintain a continuous power supply to 
the terminal to help prevent data loss. When you remove a battery pack, insert another charged battery pack in the Dolphin. If 
the main battery pack is low, insert the terminal into a charging peripheral to power the terminal and begin recharging the battery.

Note: If the main battery is low and the terminal is in suspend mode, pressing the SCAN trigger does not wake the Dolphin 
terminal; you must replace the discharged battery with a fully charged battery.

Default Low and Critical Battery Points
The Dolphin terminal ships with default low and critical battery points programmed in the following registry parameters:

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Power\LowBatt=19]

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Power\CriticalBatt=a]

The Navigation bar at the top of the each screen displays battery warning icons when the main battery reaches the low, then 
critical battery points. 

Note: Battery power warnings do not appear when the terminal is running on external power.

Registry Parameter Description

LowBatt Sets the Low Battery point. The default is 25% (Hexadecimal=19). This is the point at which you are 
warned by an icon in the Navigation bar that the battery is low. 
You are notified only once for a low battery. 

CriticalBatt Sets the Critical Battery point. The default is 10% (Hexadecimal=a). This is the point at which the 
you are warned by an icon in the Navigation bar that the battery is very low. 
This warning is posted every three minutes until the situation is corrected. 
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Setting Critical and Low Battery Points

Developers can re-reset the default battery points in the RegEdit Power Tool. 

1. Tap Start > Power Tools > RegEdit. 

2. Drill-down to HKEY_LOCAL_MACHINE > System > CurrentControlSet > Control > Power. The CriticalBatt and LowBatt 
values appear in the list.

3. Tap the Value Name to change the Value Data. You can reset the Value Data from 0 (no warning) to 99 (would warn 
whenever the charge drops below 99%). 

4. Tap OK to save changes.

Note: For more information about the RegEdit Power Tool, refer to the Dolphin Power Tools User’s Guide, which is available for 
download at www.handheld.com.

Checking Battery Power
Tap Start > Settings > System tab > Power. The Battery tab opens displaying the charge status of the main battery pack.   

For more information, see Power on page 6-11.

Storage Guidelines
To maintain optimal battery performance, follow these storage guidelines:

• Avoid storing batteries outside the specified range of -4° to 104° F (-20° to 40°C) or in extremely high humidity.
• For prolonged storage, do not keep batteries stored in a charger that is connected to a power source. 

Guidelines for Battery Use and Disposal
The following are general guidelines for the safe use and disposal of batteries:

• Use only the battery supplied, recommended, or approved by Hand Held Products. 
• Replace defective batteries immediately; using a defective battery could damage the Dolphin terminal.



3 - 12 Rev (b)
5/15/2007

Dolphin® 7850 Series User’s
Guide–Preliminary

• Never throw a used battery in the trash. It contains heavy metals and should be recycled according to local guidelines. 
• Don’t short-circuit a battery or throw it into a fire. It can explode and cause severe personal injury.
• Excessive discharge damages a battery. Recharge the battery when your terminal indicates low battery power.
• Although your battery can be recharged many times, it will eventually be depleted. Replace it after the battery is unable to 

hold an adequate charge.
• If you are not sure the battery or charger is working properly, please send it to Hand Held Products or an authorized Hand 

Held Products service center for inspection.
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Resetting the Terminal

There are two ways to reset the Dolphin terminal: a soft reset and a hard reset. 

Soft Reset (Warm Boot)
A soft reset re-boots the device without losing RAM data. You would perform a soft reset 1) when the terminal fails to respond, 
2) after installing software applications that require a reboot, or 3) after making changes to certain system settings.

1. Press and hold the Red  + ESC  keys for approximately five seconds. The screen turns white and the decode and 
scan LEDs flash for approximately three seconds. 

2. When the reset is complete, the Today screen appears.

Hard Reset (Cold Boot)
A hard reset erases all of the data and applications stored in RAM memory and launches Autoinstall, which re-initializes the 
terminal.

1. Press and hold the Red  + Tab  keys for approximately five seconds. The screen turns white and the decode and 
scan LEDs light for approximately three seconds. 

2. The terminal re-initializes; see Boot the Terminal on page 2-1.

Note: Hard resets automatically launch a soft reset before ending on the Today screen.

Set the time and date after each hard reset to ensure that the system clock is real-time. Tap the date on the Today screen to 
open the Clock and set the time and date. 

Suspend Mode 

Suspend mode suspends terminal operation. The terminal appears to be “off” when in suspend mode.

The terminal is programmed to go into suspend mode automatically when inactive for a specific period of time. You can set this 
time period in the Power setting. For details, see the Advanced Tab section of the Power (see page 6-11) setting.

To Put the Terminal in Suspend Mode

Press the Blue  + Backlight  keys. You should put the terminal in suspend mode when you change the battery pack; 
see Installing the Main Battery Pack on page 3-9.

To Resume Terminal Operation
To resume terminal operation (or “wake” the terminal), 

• Press the Backlight key .
• Press the Scan Trigger (see page 3-5).

Troubleshooting
If the terminal does not wake when you press the scan trigger,

• The battery door may not be fully closed. The mechanical switch under the battery door prevents the terminal from resuming 
operation until the door is closed.

• The main battery might be too low to resume operation. Remove the battery and install a fully charged battery or connect the 
terminal to a Dolphin charging peripheral. 
 

!
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Dolphin 7850 Technical Specifications

Feature Description

Form Factor Compact handle-style mobile computer 

Operating System Microsoft Windows Mobile 5.0 

Development 
Environment

Hand Held Products Dolphin SDK for Visual Studio 2005–supports C/C++, C# and Visual Basic 
development on Visual Studio 2005

CPU Intel PXA 270
520 MHz 

Memory 64MB X 64MB & 128 MB RAM X 128 MB Flash memory options available

Display 3.5 in. 1/4 VGA 240x320 TFT color display w/ polycarbonate industrial-grade touch panel 

Imager/Scanner 5100SR/SF VGA Area Imagers with bright green LED aimer 
5300SR/SF VGA Area Imagers with High-Vis aiming pattern
5300HD VGA Area Imagers with High-Vis aiming pattern
HP (High Performance) Laser scanner (future option)
LR (Long Range) Laser scanner (future option)
ALR (Advanced Long Range) Laser scanner (future option)

Keyboards 24-key calculator-style numeric with scrolling alpha 
38-key calculator-style numeric with full alpha

Communications 100K duty-cycle plugable/dockable RS232/USB connector, IrDA, Audio beeper 

Power 

Battery Type Lithium-ion 7.4V, 14.1 Watt-hour, hot-swappable battery pack

Capacity 14.1 Watt-hours

Run Time WLAN:  11 hours at 1 scan/6 sec, 1 data package logged every scan, 802.11b/g continuous 
connection, display backlight on full device suspend mode: 8 days minimum 

Charging 9.5V AC input through handle charge port or USB/Serial connector, four hours recharge 

Charging 
Peripherals

AC wall adapter, Charge/Communication Cable, single bay Home Base, 4 bay Charge Base, 
battery Quad Charger 

Wireless Radios 

WLAN Standard 802.11b/g

WLAN Security WEP, 802.1x, LEAP, WPA 1.0 & 2.0, TKIP, MD5, TLS, TTLS, PSK, PEAP, Cisco CCX compliant 

WPAN (optional) Bluetooth class 2, version 1.2 (optional feature) 

Co-Located/
Operational

Two radios:  WLAN/WPAN 
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Physical

Operating 
Temperature 

Standard configuration is 14°—122°F / -10°—50°C nominal; -4° (-20°C) with reduced runtime 
Optional Bluetooth configuration is 32°—104°F / 0°—40°C

Construction Magnesium alloy internal chassis with component shock mounts
Engineering-grade polycarbonate outer housing with integrated rubber over-molded handle 

Structural 5 ft. (1.5m) multiple drops to concrete, all surfaces, across operating temperature range
Exceeds 2,000 3 ft. (1m) tumbles

Environmental IP64 rated for blown dust/water intrusion 

Dimensions Main housing: 
7.1 in. Long X 3.3 in. Wide X 1.4 in. Deep (18 cm Long X 8.4 cm Wide X 3.6 cm Deep)
Handle: 4.6 in. Long X 1.6 in. Wide X 1 in. Deep (12 cm Long X 4.1 cm Wide x 2.5 cm Deep)

Weight Approximately 20 oz./567 g

Warranty Standard: 2 years on terminal; 1 year on battery.

Dolphin 7850 Technical Specifications

Feature Description
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4
Using the Keyboards

Overview

The keyboard buttons are recessed under the overlay for maximum durability. The keyboard panel is backlit for maximum 
viewability in various lighting conditions.

The Dolphin 7850 has two keyboard options: 

Calculator Style Numbering
Both Dolphin 7850 keyboards default to numeric mode and feature calculator-style numbering for ease-of-use in the field.

LEDs
The LEDs are in the center of the keyboard.

Scan LED The LED on the right lights red when you press the Scan trigger in scanning applications.

Decode LED The LED on the left lights green when a scanned bar code is successfully decoded.

Note: Both LEDs are user-programmable.

For more information, see Using the Image Engine on page 5-1.

Color-Coding
Keyboard overlays are color-coded to indicate the functions performed or characters typed when the color-coded key is pressed 
with the red or blue modifier key. 

Keyboard Mode Indicator
Dolphin terminals have a Keyboard Status Power Tool (Start > Power Tools > Keyboard Status) that displays an icon in the 
Navigation bar to indicate if the keyboard is in alpha or number mode. Keyboard Status is active by default.

Indicates that the keyboard is in numeric mode.

Indicates that the keyboard is in alpha mode, uppercase.

Indicates that the keyboard is in alpha mode, lowercase.
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Key Types
In addition to the standard number and letter keys, both keyboards contain three types of keys:

1. Function Keys: Using the Function Keys (see page 4-2)

2. Navigation Keys: Using the Navigation Keys (see page 4-3) 

3. Modifier Keys: Using the Modifier Keys (see page 4-3)

Using the Function Keys

Function keys perform specific functions and usually have the name of the function they perform.

Note: There is no SCAN key on the Dolphin 7850 keyboard; scanning is initiated with the Scan Trigger (page 3-5).

Name Key Function

Backlight Toggles the keyboard backlight on and off.

Backspace 
(BKSP)

To backspace, press Red + left arrow.
Backspace moves the cursor back one space and deletes each time the key combination 
is pressed. If you are typing text, a character is deleted each time you backspace.

Backtab
(BKTAB)

To backtab, press the Blue + TAB.
Backtab moves the cursor back to the previous tab stop or field (on a form or application 
window).

Delete 
(DEL)

To delete, press Blue + ESC. 
Deletes the next character forward. One character is deleted each time the key 
combination is pressed.

Escape Cancels an action.

OK Functions as an Enter key. 

Resume Resume the terminal by pressing Blue + Backlight. 
Note: You can also press the Scan trigger on the handle.

Space (SP) To space, press Red + right arrow. Space moves the cursor one space forward. If you are 
typing text, it moves the text one space forward as well.

Tab Moves the cursor to the next tab stop or field (on a form or application window).
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Using the Navigation Keys

Located in the center of each keyboard for easy access with either hand, the navigation keys enable you to navigate the cursor 
through an application screen.

The navigation keys perform additional system functions when pressed in combination with the Blue and Red modifier keys. For 
details, see the key combination tables for the 24-Key Keyboard (page 4-4) and the 38-Key Keyboard (page 4-8).

Additional functionality of the navigation keys varies according to the application in use.

Using the Modifier Keys

Modifier keys modify the next key pressed to perform functions or type special characters. The Dolphin 7850 has Blue and Red 
modifier keys with a color-coded overlay so you can see what the key combination does. 

Press To …

Move the cursor up one row or line.
Move the cursor down one row or line.

Move the cursor one character to the right.

Move the cursor one character to the left.

Name Key Function

Shift Provides shift functionality for application windows.
Tap once to modify the next letter pressed.Tap twice 
for caps lock.

Blue and
Red 

Modifies the next key pressed. The overlay of each 
keyboard is color-coded to indicate the character 
typed or function performed with both keys. 

Alpha On the 38-key keyboard, the Alpha key toggles the 
keyboard between alpha and numeric modes. 
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24-Key Keyboard

The following graphic displays the 24-key numeric keyboard.

Toggling Between Alpha and Numeric Modes
The 24-key keyboard defaults to numeric mode. Numeric mode is when you type numbers with the number keys. 

• Double-tap the Blue modifier key to toggle between alpha and numeric modes.
• Single-tap the Blue modifier key to toggle to alpha or numeric mode only for the next key pressed. The keyboard returns to 

the previous state before the next key pressed.
• Press and hold the Blue modifier key to toggle to alpha or numeric mode for all keys pressed until the Blue modifier key is 

released.

Alpha Mode 

Alpha mode is when you type the letters or characters indicated in blue on the number keys.

Please note that when typing in alpha mode, you must use the same multi-press method you would use when typing letters on 
a phone keypad. Each key press types the next letter in the sequence as displayed by the alpha indicator.

You can still use the Blue modifier key for regular Blue key combinations in alpha mode; just press the Blue modifier key and the 
next key. For combinations, see 24-Key Blue Key Combinations on page 4-6. 

Shift Functionality in Alpha Mode

The SFT key performs all the normal windows shift key functions alpha mode, including capitalizing one letter. On the 24-key 
keyboard, the SFT key also toggles caps lock on and off.

• Single-tap the SFT key to modify the next key pressed; if this is a letter, that letter is capitalized.
• Double-tap the SFT key to toggle caps lock on and off in alpha mode.

Note: Check the mode indicator (see Keyboard Mode Indicator on page 4-1) in the Navigation bar to see what mode the 
keyboard is in.
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24-Key Blue Key Combinations

Alpha Mode

Functions

Key Character
Lower case

Character
Upper case:
SFT once for the next key
SFT twice for caps lock

8 abc ABC

9 def DEF

4 ghi GHI

5 jkl JKL

6 mno MNO

1 pqrs PQRS

2 tuv TUV

3 wxyz WXYZ

* * *

, @  ?  ! @  ?  !

Key Combination Function

Blue + Backlight Suspend

Blue + ESC Delete

Blue + Tab Backtab

Blue + Up Arrow Volume up

Blue + Down Arrow Volume down

Blue + Right Arrow Insert
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24-Key Red Key Combinations

Key Combination Function/Special Character

Red + Left Arrow Backspace

Red + Right Arrow Space

Red + Up Arrow Page up

Red + Down Arrow Page down

Red + ESC (hold) Soft reset (warm boot)

Red + TAB (hold) Hard reset (cold boot)

Red + 1 F7

Red + 2 F8

Red + 3 F9

Red + 4 F4

Red + 5 F5

Red + 6 F6

Red + 7 F1

Red + 8 F2

Red + 9 F3

Red + 0 F10

Red + * #
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38-Key Keyboard

The following graphic displays the 38-key alpha keyboard.

Toggling Between Numeric and Alpha Modes 
The 38-key keyboard defaults to numeric mode. Numeric mode is when you type numbers with the number keys. Alpha mode is 
when you type the letter indicated on the overlay when you press the number key. 

Alpha Mode 

Single-tap the ALPH key  to toggle to alpha or numeric mode only for the next key pressed. 

Shift Functionality in Alpha Mode

The SFT key performs all the normal windows shift key functions in alpha mode, including capitalizing one letter. On the 38-key 
keyboard, the SFT key also toggles caps lock on and off.

• Single-tap the SFT key to modify the next key pressed; if this is a letter, that letter is capitalized.
• Double-tap the SFT key to toggle caps lock on and off in alpha mode.

Note: Check the mode indicator (see Keyboard Mode Indicator on page 4-1) in the Navigation bar to see what mode the 
keyboard is in.
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Alpha Mode Keys

Key Character
Lower case

Character
Upper case:
SFT once for the next key
SFT twice for caps lock

7 a A

8 b B

9 c C

- d D

F10 e E

4 f F

5 g G

6 h H

+ i I

F9 j J

1 k K

2 l L

3 m M

\ n N

F8 o O

. p P

0 q Q

, r R

/ s S

F7 t T

F1 u U

F2 v V

F3 w W

F4 x X

F5 y Y

F6 z Z
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38-Key Blue Key Combinations  

38-Key Red Key Combinations  

Key Combination Function

Blue + Backlight Suspend/Resume

Blue + ESC Delete

Blue + Right Arrow Insert

Blue + Up Arrow Volume up

Blue + Down Arrow Volume down

Blue + ALPH Start menu

Blue + Tab Backtab

Blue + F2 *

Blue + F3 @

Blue + F4 #

Key Combination Function

Red + Left Arrow Backspace

Red + Right Arrow Space

Red + ESC (hold) Soft reset (warm boot)

Red + TAB (hold) Hard reset (cold boot)
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5
Using the Image Engine

Overview

The Dolphin 7850 terminal houses a compact image engine using Adaptus Imaging Technology 5.0™ that instantly reads all 
popular 1D and 2D bar codes and supports omni-directional aiming and decoding. The image engine can also capture digital 
images, such as signatures and pictures of damaged inventory.

Available Image Engines

Dolphin 7850 terminals may be equipped with one of the following image engines: 

Available Laser Engines

Dolphin 7850 terminals can be equipped with one of the following laser engines:   

5100 Standard Range (5100SR)
5300 Standard Range (5300SR)

8.3 mil 
Linear 

10 mil 
PDF417 

13 mil 
UPC 

15 mil 
Data Matrix 

15 mil 
QR 

35 mil 
MaxiCode

*Working Range: (.020cm) (.025cm) (.033cm) (.038cm) (.038cm) (.089cm)

Near 3.5 in. 
(8.9cm) 

3.1 in. 
(7.9cm) 

2.1 in. 
(5.3cm) 

2.3 in. 
5.8cm) 

3.1 in. 
(7.9cm) 

2.0 in. 
(5.1cm)

Far 7.6 in. 
(19.3cm) 

9 in. 
(22.9cm) 

13.2 in. 
(33.5cm) 

10.2 in. 
(25.9cm) 

8.8 in. 
(22.4cm) 

13.0 in. 
(33cm) 

High Performance (HP)

Code 5 mil 55 mil reflective

Working Range

Near 2.75 in (0.07 m) 5 in (0.13 m)

Far 7 in (0.17 m) 50 in (1.27 m)

Long Range (LR)

Code 10 mil 100 mil reflective

Working Range

Near 10 in (0.25 m) 66 in (1.67 m)

Far 24 in (0.6 m) 232 in (5.9 m)

Advanced Long Range (ALR)

Code 13 mil 100 mil reflective

Working Range

Near 18 in (0.45 m) 102 in (2.6 m)

Far 39 in (1 m) 363 in (9.2 m)
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Supported Bar Code Symbologies

The Dolphin 7850 image engines support the following bar code symbologies: 

Symbology Type Symbology Name

1D Symbologies Codabar 
Code 3 of 9
Code 11
Code 32 Pharmaceutical (PARAF) 
Code 93 
Code 128 
EAN with Add-On
EAN with Extended Coupon Code 
EAN-13 
GS1 Databar
Interleaved 2 or 5 

Matrix 2 of 5 
Plessey 
PosiCode 
Straight 2 of 5 IATA
Straight 2 of 5 Industrial
Telepen 
Trioptic Code
UCC/EAN-128
UPC and UPC-A

2D Symbologies Aztec
Code 16K
Composite
Data Matrix
GS1 Databar
MaxiCode
OCR
PDF417
QR Code 

Composite Codes Aztec Mesa
Codablock F
EAN·UCC
GS1 Databar-14

OCR OCR US Money Font, MICR (E 13 B) and SEMI Font
OCR-A 
OCR-B

Postal Codes Postnet and most international 4 state codes 
Australian Post
British Post
Canadian Post
China Post 
Japanese Post
KIX (Netherlands) Post 
Korea Post
Planet Code
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Activating the Engine

The Dolphin 7850 features a scan trigger on the front of the integrated pistol-grip handle that activates the image engine.

Using Demos
Dolphin Demos are software utilities loaded on all Dolphin terminals that demonstrate the advanced features of the terminal. 
There are two Demos feature the image engine: Image Demo and Scan Demo.

To access these demos, tap Start > Demos,

• Select Image Demo to verify imaging, or
• Select Scan Demo to verify decoding.

For more information about Demos, refer to the Dolphin Demos User’s Guide, which is available for download from 
www.handheld.com.

LEDs
The LEDs in the center of both keyboards (for location, see LEDs on page 4-1) light when using the image engine.

Scan LED The LED on the right lights red when you press the scan trigger in scanning applications.

Decode LED The LED on the left lights green when a scanned bar code is successfully decoded.

Decoding

The Dolphin terminal supports two types of image decoding: full-area imaging and Advanced Linear Decoding (ALD).

Full-area Imaging

Full-area imaging means that the Dolphin terminal support omni-directional aiming, which means that a positive 
read can be obtained from many positions. For details, see Omni-Directional Scanning Positions on page 5-4. 

ALD

ALD provides fast reading of linear (1D) and stacked linear bar codes (e.g., PDF417). For the best read, the aiming 
pattern should be centered horizontally across the bar code. When ALD is enabled, the reader does not read matrix 
or postal codes.

Scan Trigger
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To Decode a Bar Code
1. Tap Start > Demos > Scan Demo.

2. Position the Dolphin terminal over one of the sample bar codes on page 5-4.
A range of 4–10 inches (10–25 cm) from the bar code is recommended. 

3. Project the aiming pattern by pressing and holding the Scan trigger. The Scan LED lights red.

4. Center the aiming beam over the bar code. The aiming beam should be oriented in line with the bar code to achieve optimal 
decoding; see Omni-Directional Scanning Positions on page 5-4.

5. Release the Scan trigger.

6. When the bar code is successfully decoded, the decode LED lights green and the terminal beeps.

Sample Bar Codes
You can use the following bar codes to verify decoding:

Omni-Directional Scanning Positions
 The high-vis aiming pattern frames the bar code to provide you with the best scanning performance. 

Note: To achieve the best read, the aiming beam should be centered horizontally across the bar code. 

The aiming pattern is smaller when the terminal is held closer to the code and larger when the terminal is held farther from the 
code. Symbologies with smaller bars or elements (mil size) should be read closer to the unit whereas larger bars or elements 
(mil size) should be read farther from the unit.

Laser Engines
Laser engines do not support omni-directional scanning. To achieve an optimal scan, center the red aiming beam across the bar 
code horizontally as shown.

Sample 128 Sample PDF417

Code 128 PDF417 Test Message
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Capturing Images

The image-capture process is an intuitive, split-second operation for experienced users. By following basic guidelines, however, 
new users can easily develop their own technique and, with practice, quickly learn to adapt to different application environments.

Image Preview

When the imaging process is initiated, the screen displays a preview of the object. This is a live video image of what 
the imager is currently viewing and has a slightly degraded appearance compared to the captured image. This slight 
degradation is normal; the captured image has a higher resolution.

File Formats

The Dolphin terminal is capable of saving images in a number of industry-standard file formats such as *.bmp, *.jpg 
and *.png. The default file format for images is a grayscale *.jpg. To obtain the highest quality images, take 
grayscale images.

File Size

Digital images have a maximum image size of 640 x 480 pixels and an image definition up to a 256 grayscale. The 
image quality and related file size are determined by the data compression method used by the software application 
used to take the image. The average size of the image file is approximately 4–8K. However, the size of the image 
depends on image content; the more complex the content, the larger the file size. 

Taking an Image
1. Tap Start > Demos > Image Demo.

2. Point the Dolphin 7850 terminal at the object.

3. Press the scan trigger to activate the engine. The screen displays a preview of the object.

4. Adjust the terminal’s position until the preview on the screen appears as you want it to appear in the image.

5. Hold the terminal still and release the Scan trigger. The screen flashes and the captured image appears on the screen. 

6. By default, the image is saved to the My Device folder (Start > Programs > File Explorer > My Device). 
To save the image to another location, tap File > Save As.

High-Vis Aiming Pattern

If your Dolphin terminal is configured with an 5300 imager, you can enable the aiming pattern for imaging in the Image Demo 
application. For details about the aiming pattern, see Omni-Directional Scanning Positions on page 5-4.

1. Tap Start > Demos > Imaging Demo > Options menu > Aimer.

2. The aiming pattern is now enabled for imaging.

Uploading Images
Image files can be transmitted to a host workstation via 

• Microsoft ActiveSync and a Dolphin communication peripheral, or 
• Over your wireless radio network.
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6
Settings

Overview

Customizable settings are available from the Start menu. Tap Start > Settings and the Settings screen opens displaying the 
Personal tab. Settings consists of three tabs: Personal, System, and Connections.    

Tab Description

Personal The Personal tab provides access to personal configuration programs.
For details, see Personal Settings on page 6-2.

System The Systems tab provides action to programs that monitor and adjust major system functions.
For details, see System Settings on page 6-7.

Connections The Connections tab provides access to most of the terminal’s communication options.
For details, see the Connections Tab (see page 7-6) in the Communication chapter.

Personal Tab System Tab Connections Tab
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Personal Settings

To access the Personal tab, go to Start > Settings. The screen opens displaying the Personal tab.

Note: Personal settings are stored in RAM memory and are replaced by system defaults after each hard reset. For more 
information about resets, see Resetting the Terminal on page 3-13.

Icon Description

Buttons Programs hardware buttons to launch applications or execute commands; see Buttons on page 6-3. 

Input Customizes the SIP. For details, see Input Panel Options on page 6-4.

Lock Provides password protection for certain programs on the terminal. 

Menus Customizes what appears on the Start and New menus; see Menus - Modifying the Start Menu on 
page 6-4.

Owner 
Information

Stores your contact information. This information will appear on the Today screen.

Sounds & 
Notifications

Sets the sound volume, enables and disables sounds for specific actions, and sets sound parameters 
for system notifications.

Today Customizes the look and the information that is displayed on the Today screen.



Dolphin® 7850 Series User’s Guide–
Preliminary

Rev (b)
5/15/2007

6 - 3

Buttons
The Buttons setting programs keyboard buttons to launch applications or execute commands. The default button assignments 
that appear on the Buttons window are inactive until you enable the HotKeys Power Tool.

You must enable the HotKeys Power Tool to activate the button assignments in the Buttons setting. 

1. Tap Start > Power Tools. 

2. Tap the HotKeys icon once . 

3. HotKeys is enabled and the button assignments in the Buttons setting are active.

4. Verify the button assignment by tapping the button on the keyboard. 

For more information about HotKeys, refer to the Dolphin Power Tools User’s Guide, which is available for download from 
www.handheld.com.

Changing Button Assignments

1. After HotKeys is enabled, tap Start > Settings > Personal tab > Buttons.  

Note: The buttons that appear on this window are the only buttons that can be programmed via the Buttons setting. You cannot 
add hardware buttons to this window.

2. Tap on the name of the application in the Assignment column and select a program or command in the Assign a program 
drop down list. 

3. Tap OK to save.

Available Programs

The Assign a program list contains the applications installed on the terminal. If there is a program installed that you would like 
to see in this list, paste a Shortcut to the program in the \\Windows\Start Menu\Programs folder. 

For instructions about creating shortcuts, see Using File Explorer on page 6-5.

Commands

The Assign a program list also contains the following commands: 

Command Description

<Input Panel> Opens the soft input panel.

<None> Nothing happens when the button is pressed.

<OK/Close> Performs the same function as tapping OK on the screen.
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Input Panel Options
You can set input options by going to Start > Settings > Personal tab > Input. The following graphics are the tab windows where 
you can customize the SIP (soft input panel) to your preferences:

Menus - Modifying the Start Menu
You can add existing programs you use often, such as File Explorer, to the Start menu for faster access. You are not installing 
the program, just enabling the user to access the program from the Start menu.

You can add a program to the Start Menu three ways: directly by using the Menus setting, or creating and pasting shortcuts in 
File Explorer on the terminal or the workstation (and using ActiveSync to transfer to the shortcut to the terminal).

Note: Only seven applications total are allowed on the Start menu.

Using the Menu System Setting

1. Tap Start > Settings > Personal tab > Menus > Start Menu tab. 

2. Tap the check box for the program you want to add and tap OK to save.

<Scroll Down> Scrolls down in the open application.

<Scroll Left> Scrolls left in the open application.

<Scroll Right> Scrolls right in the open application.

<Scroll Up> Scrolls up in the open application.

<Start Menu> Opens the Start menu.

<Today> Opens the Today screen.

Input tab Word Completion tab Options tab

Command Description
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3. Tap the Start menu to verify that the program appears on it.

Using File Explorer

If you do not see the program listed, you can either use File Explorer to move the program or ActiveSync on the desktop computer 
to create a shortcut to the program and place the shortcut in the Start Menu folder.

Note: We recommend that you Copy and Paste Shortcut so that you do not alter your program configurations by accident. Using 
Copy and Paste Shortcut (as opposed to Cut/Copy and Paste) ensures that the program files remain where they need to 
be for the system to find them to perform system functions.

1. Tap Start > Programs > File Explorer, and navigate to the program.
File Explorer opens to My Documents by default; to see a list of all folders, tap the folder name and then My Device. 

2. In File Explorer, navigate to the \Program Files folder. Tap and hold on a program, then select Copy on the pop-up menu. 

3. Navigate to the Windows folder and open the Start Menu folder (My Device > Windows > Start Menu), tap and hold a blank 
area of the window, and tap Paste Shortcut on the pop-up menu. 
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4. The shortcut is now in the folder.

5. Tap the Start menu to verify that the program now appears on it.

Using Windows Explorer

Here, you are performing the same basic process as on the terminal, except that you are using the Explore utility in ActiveSync 
(Windows Explorer) to copy and paste the shortcut from the workstation to the terminal. For more details using Explore in 
ActiveSync, see Exploring the Terminal from the Workstation on page 7-4.

1. Using a Dolphin peripheral, connect the terminal to the workstation via ActiveSync.

2. On the workstation, when ActiveSync opens after connecting, tap Explore. Windows Explorer opens to the files on the 
terminal.

3. Navigate to the program.

4. Right-click on the program and select Create Shortcut. 

5. Select the shortcut, right-click, and select Cut.

6. Navigate to the Start Menu folder (Windows > Start Menu).

7. Right-click on an empty area and select Paste Shortcut. 

8. On the terminal, tap the Start menu and verify that program appears. 



Dolphin® 7850 Series User’s Guide–
Preliminary

Rev (b)
5/15/2007

6 - 7

System Settings

The System tab enables you to verify and sometimes alter system parameters. 

To access the System tab, go to Start > Settings > System tab. 

About
The About system setting displays specific information about what is loaded on the terminal on three tab windows: 

Backlight
The backlight for the color display is user-defined. 

Tap Start > Settings > System tab > Backlight.There are two tabs: Battery and External; 
the options on each tab are the same. 

The Battery tab determines display backlight settings when the terminal is running on battery 
power. 

The External tab determines display backlight settings when the terminal is powered by an 
external source, such as a Hand Held Products cable.

Tab Description

Version Tab Displays the information about the software, operating system, and processor of the terminal.
The processor for the Dolphin 7850 is an Intel XScale PXA 270 520MHz processor.

Device ID Tab Displays the information the terminal uses to identify itself to other devices. It is important to know 
this information to identify the terminal when connecting to the network.
Device name:        Displays the system’s default name. This is the name used by ActiveSync.
Description:          Displays the description of the device ID.

Copyrights Tab Displays important copyright information.
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Brightness Tab

The Brightness tab determines the brightness of the display backlight when it’s on.  

To disable the backlight, check Disable backlight. Tap OK to save all changes.

Certificates
Certificates shows you the network certificates recognized by the operating system. There are personal and root certificates; 
each has its own tab.

It is important to verify that the operating system acknowledges your certificate. If the certificate does not appear on one of these 
tabs, the operating system does see it, and it will not function properly during the network authentication process. 

For more information, see Certificates on page 8-12.

Clock & Alarms
Clock & Alarms sets the system clock. Appointments, scheduled events, and any function on a schedule runs off this setting. You 
need to set the time and date after each hard reset. You can also access this setting by tapping the date on the Today screen.

GPS Settings
GPS Settings is a Microsoft GPS tool.
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Memory
Dolphin terminals have two types of memory: volatile and non-volatile. Data stored in volatile memory does not persist through 
cold boots (see Hard Reset (Cold Boot) on page 3-13) whereas data stored in non-volatile memory does persist through cold 
boots. Each type of memory has its own options.

Volatile

Data stored in volatile memory does not persist through cold boots. The Dolphin 7850 terminal has 64MB of volatile memory by 
default. Volatile memory is used for running and storing programs as well as storing program data and is also known as RAM 
memory.

Non-Volatile

Data stored in non-volatile Flash memory does persist through cold boots. The Dolphin 7850 terminal can have 64MB or 128MB 
of non-volatile memory.

IPSM Short for Internal Persistent Storage Manager, IPSM is the on-board Flash memory. Because this 
memory is non-volatile, data and programs stored in IPSM are not affected when power is removed 
or a cold boot launched. For this reason, default programs and files for Dolphin terminals such as 
Autoinstall are stored in IPSM. 

Secure Digital (SD) Card Hand Held Products offers 64MB, 128MB, and 256MB SD cards that can be installed at the factory. 
The SD memory interface is not user-accessible or field-replaceable.

Use the Memory system setting to check memory usage after you receive warning messages about memory. There are three 
tabs: Main, Storage Card, and Running Programs.

Main Tab

This tab displays current capacity and usage of the 64MB or 128MB of on-board, volatile memory.   

Field Description

Columns Storage: The part of RAM memory used for storing programs and program data.
Program: The part of RAM memory used to run programs.

Total Displays the current MB of memory allocated for Storage and Program use.

In use Displays the total MB of that allocated memory being used in Storage and Program 
memory functions.

Free Displays the total MB of memory available for Storage and Programs use.
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Storage Card Tab

This tab displays the current capacity and usage statistics of the selected memory type: IPSM or Storage Card. 
Select the memory type from the drop-down list. IPSM is selected by default.   

Running Programs Tab 

This tab displays the running software programs using storage memory. Check this tab when you are receiving out 
of memory errors or when the mobile computer is running slowly. Select a program in the list and tap Stop to stop 
it from running (and therefore from using memory). Tap Stop All to automatically stop all running programs.

Anytime you stop a running program, it frees up volatile memory. Be advised that, when you stop a program 
here, any unsaved data in that program is lost. To free up memory without risking data loss, return to the 
running program, save your data, and close the application.

Field Description

Total storage card… The total MB of memory capacity of the selected memory.

In use The MB currently being used.

Free The MB that is still available for use. 

Drop-down list IPSM—When IPSM is selected in the drop-down 
list, the Storage Card tab displays the IPSM 
memory capacity and usage statistics.
Storage Card—If a storage card is installed in the 
terminal, a Storage Card entry appears in the 
drop-down list. Select it to see  the current capacity 
and usage statistics of the installed storage card.

!
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Find Link 

Find searches for large files using storage memory. Clicking Find opens the 
Search program with Larger than 64KB already selected in the Type field. Enter 
the search criteria and tap Search.

Power
Battery Tab Displays battery charging information.

For more information about the terminal’s batteries, see Battery Power on page 3-9.

Advanced Tab Determines the amount of time that elapses before the terminal automatically goes into suspend 
mode; see Suspend Mode on page 3-13. 
You have the option of selecting time periods for both battery and external power. 

Field Description

On battery power Select the number of minutes of inactivity you want to pass before the terminal goes into 
suspend mode when running on battery power.

On external power Select the number of minutes of inactivity you want to pass before the terminal goes into 
suspend mode when running on external power.
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Regional Settings
Regional Settings enables you to customize the appearance and formatting to your geographic region. Specifically, you can 
customize numbers (i.e., number of decimal places allowed), currency (i.e.,using the $ or €€  symbol), time, and date. These 
specifications apply to all screens, including the Today screen. The Region tab displays an overview of the region selected in the 
drop-down list at the top. The terminal is loaded with a number of pre-programmed regional settings. Select one from the list. The 
results appear on the screen. 

To see specific settings or change a specific setting, tap on one of the tabs, make the change and tap OK to save it. You need 
to show reboot the terminal for the changes take effect. 

Remove Programs
The Remove Programs settings enables you to remove programs installed on the terminal. Use this setting to troubleshoot when 
you receive messages that the device is out of memory. The programs removed in the Remove Programs setting are removed 
from volatile memory. 

1. Tap Remove Programs. In the list, select the program you want to remove. 

2. Tap Remove. The following message appears: 

3. Tap Yes. Wait while the program is removed. 

4. Verify that the program no longer appears in the list and the total storage memory adjusts.

Total storage memory available—The available memory adjusts automatically when a program is removed; see Memory on 
page 6-9.
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Screen
Note: By default, dynamic screen rotation (i.e., the ability to switch between landscape and portrait orientation) is disabled on 

Dolphin 7850 terminals.

Alignment Tab

Tap Align Screen to re-align the screen. Remember, you first align the screen at bootup. You would need to re-
align the screen again if tapping buttons or icons with the stylus no longer seems to work appropriately. 

ClearType Tab

Dolphin terminals support ClearType font rendering. ClearType is a Microsoft technology that dramatically 
increases the readability of text on LCD displays. 

To enable ClearType font rendering, select Enable ClearType and tap OK.

For more information about ClearType font rendering, visit: www.microsoft.com/typography/cleartype/
what.htm?fname=%20&fsize=

Text Size Tab

Adjusts font scaling within certain views of the Today screen, Contacts, Calendar, Messaging, and Tasks. This 
means that you can increase or decrease the point size of the font on application windows.

This is the default font size setting. To change the font size, move the slider toward Smallest or Largest. The 
Example text changes to reflect the font change. Tap OK to save the new font size setting.  

Default Font Size Largest Font Size
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7
Communication

Communication Options

Dolphin terminals offer several communication options including Microsoft ActiveSync, infrared, and wireless radios.

Mechanical Connector

The mechanical connector on the bottom panel (for the exact location, see Mechanical Connector on page 3-8) 
connects the terminal to a series of Dolphin peripherals, which connect to a host workstation via USB (1.1 or higher). 
When the terminal is connected to a host workstation in this way, you can use ActiveSync to communicate between 
the host and the terminal. 

For more information about communicating with ActiveSync, see Using ActiveSync on page 7-3.

IrDA Port

The IrDA port enables the Dolphin 7850 to transmit data via pulses of infrared light to and from other IrDA-compliant 
devices, such as printers, PCs, and even other Dolphin terminals. 

For more information about communicating via the IrDA port, see Using Infrared Communication on page 7-8. 

Wireless Radios

Dolphin 7850 terminals can be equipped with an 802.11g and/or Bluetooth radio. When the terminal’s radios are 
enabled, you can connect the terminal to a wireless network for communication.

For more information about enabling the radios, see Radio Manager on page 7-13.

Software Communication Programs
Dolphin terminals are shipped with the following communication software programs installed.

Microsoft ActiveSync v4.1 or Higher

Microsoft ActiveSync is a tool that enables mobile computing devices to exchange and synchronize application data 
with a desktop computer. For more information, see Using ActiveSync on page 7-3.

Remote Access Services (RAS)

RAS is a feature built into Windows NT that enables users to log into an NT-based LAN using a modem, X.25 
connection or WAN link. RAS is fully supported and allows the use of Point-to-Point Protocol (PPP) or Serial Line 
IP (SLIP) connections for network connectivity.

To establish a RAS connection, enable the terminal’s radio(s) in the Radio Manager (see page 7-13), set the 
terminal up on a wireless network, then activate the RASMan Power Tool by tapping Start > Power Tools > 
RASMan. 

For more information about Power Tools, refer to the Dolphin Power Tools User’s Guide, which is available for 
download from www.handheld.com.
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Default Com Port Assignments

The Dolphin terminal ships with the com ports assigned as follows: 

Installing Additional Software

Dolphin terminals ship with the operating system, radio drivers, and custom Hand Held Products software loaded onto the device. 
These are the default programs that install when your terminal first boots up. You can install additional software programs to the 
terminal provided that the following parameters are met:

• The software program was created for a Windows Mobile device.
• The terminal has enough memory to store and run the program.
• The program has an *.exe, *.cab, or *.dll extension. 

The most popular place to find software on the Windows Mobile website: www.microsoft.com/windowsmobile/products/pocketpc/

When selecting programs, verify that the program and version of the program are designed for the Windows Mobile 5.0 and the 
terminal’s processor. You can verify your processor by tapping Start > Settings > System tab > About > Version tab. Make a note 
of the information in the Processor field. 

To install additional software, you can use the communication options described in this chapter.

See,

• Adding Programs via ActiveSync, page 7-4.
• Adding Programs From the Internet, page 7-7.
• Adding Programs via Infrared, page 7-9.

Com Port Assignment

1 Serial port; this is the 17-pin mechanical connector on the bottom panel. 
See Mechanical Connector on page 3-8.

2 Bluetooth Module 
If there is no Bluetooth hardware installed on the terminal, this com port is unassigned.

3 Raw Infrared

4 Unassigned

5 USB virtual serial port

6 IrDA, if IrDA is enabled. If IrDA is disabled, this com port becomes available. 

7, 8, & 9 Unassigned
These are virtual com ports that are available for selection only when connecting to devices that 
use virtual com ports, such as Bluetooth.

!

http://www.microsoft.com/windowsmobile/products/pocketpc/
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Using ActiveSync

ActiveSync communication happens through the mechanical connector on the bottom panel (see Mechanical Connector on page 
3-8) when the terminal is connected to a Dolphin communication peripheral such as the Dolphin HomeBase or a Dolphin Charge/
Communication cable.

Hardware Requirements

• Dolphin HomeBase or Dolphin communication cable: USB or RS-232
• Power Adapter Cable from Hand Held Products

Software Requirements

To synchronize, ActiveSync 4.1 or higher must be installed and configured for the appropriate communication type on the host 
workstation and the Dolphin terminal. Dolphin terminals ship with ActiveSync already installed. Therefore, if ActiveSync is already 
installed on the host workstation, you just need to connect the Dolphin terminal to the host workstation (via Dolphin peripheral) 
to initiate communication.

If ActiveSync 4.1 or higher is not installed on the host workstation, install it from the Microsoft Companion CD that came with the 
Dolphin terminal. Insert the CD into the CD-ROM drive of the host workstation and click the yellow arrow, then Start Here, and 
follow the directions on your screen. You can also download the most current version of ActiveSync from www.microsoft.com 
and install.

The host workstation must have Windows 98 Second Edition*, Windows Me, Windows 2000, or Windows XP installed. 

Note: The HomeBase does not support Windows NT when using a USB connection because Windows NT does not support USB. 
*Windows 98 Second Edition provides full USB support.

Setting Up the Host Workstation
To sync successfully, ActiveSync must be configured for same communication type on the host workstation and the Dolphin 
terminal. ActiveSync must be setup on your desktop computer before you initiate synchronization from the terminal for the first 
time.

Verify that ActiveSync on the host workstation has selected the appropriate communication type by opening ActiveSync and 
clicking File > Connection Settings.

Note: You can have both USB and RS-232 selected in the software without affecting processing. However, your hardware setup  
should use only RS-232 or USB, not both.

Setting Up the Terminal
When communicating via ActiveSync, your terminal must be connected to the host workstation with a communication peripheral 
sold/manufactured by Hand Held Products, such as the Dolphin HomeBase or Dolphin Charge/Communication cable. Use of any 
peripheral not sold/manufactured by Hand Held Products may damage your terminal and will void the warranty.

You need to connect the Dolphin peripheral to the host workstation, then connect the Dolphin terminal to the peripheral. 
ActiveSync should attempt to connect automatically and self-configure to RS-232 or USB. Dolphin terminals default to USB 
communication.

Verify the connection setting on the Dolphin terminal by tapping Start > Programs > ActiveSync > Menu > Connections.

For USB communication, 
check Allow USB connections.

For RS-232 communication, 
connect to COM1.

!
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USB The default workstation synchronization value for USB communication is ‘USB Connection.

RS-232 The default workstation synchronization value for RS-232 communication ‘115200 Default.

Synchronizing with the Host Workstation
After setup, synchronization begins automatically whenever the terminal’s mechanical connector connects to a Dolphin 
peripheral that is connected to a host workstation with ActiveSync installed. 

Note: If you have a wireless LAN card, you can also synchronize remotely. 

Exploring the Terminal from the Workstation
When the terminal and desktop computer are connected, open the main ActiveSync window (on the desktop), and click Explore.

The Mobile Device folder opens in Windows Explorer. 

The Dolphin terminal is now treated as a mass storage device, and transferring files is as simple as dragging and dropping or 
copying and pasting as you would for moving files between folders on your hard drive.

Adding Programs via ActiveSync
When selecting programs, verify that the program and version of the program are designed for Windows Mobile 5.0 and your 
processor. You can verify your processor by tapping Start > Settings > System tab > About > Version tab. Make a note of the 
information in the Processor field. 

Generally, software for Windows Mobile devices must be installed to the host workstation first, then transferred to the Dolphin 
terminal. 

1. Download the program to the workstation from either the Internet or the installation CD. You may see a single *.exe or 
setup.exe file, a *.cab file, or *.dll. (There may also be several versions of files for different device types and processors.)

2. Read any installation instructions provided by the program, such as Read Me files or other documentation. Many programs 
provide special installation instructions.

3. Connect the terminal to the workstation via Hand Held Products communication peripheral.

4. Confirm that ActiveSync activates.

If the Program File is Self-Extracting

This type of program installs to the workstation and the terminal simultaneously; one process installs to both devices.

1. On the workstation, double-click the *.exe or *.setup.exe file. The installation wizard begins. 

2. Follow the directions on the workstation screen. The installation process includes transferring the software to the terminal 
via ActiveSync. 

!
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If the Program File is Not Self-Extracting

Some programs cannot be installed on workstations because they are designed exclusively for Windows Mobile devices. In these 
cases, the appropriate files must be stored on the host workstation and transferred to the terminal via ActiveSync Explore. 

Note: You know that the program is not an installer because an error message stating that the program is valid but designed for 
a different type of computer appears when you try to install the program on the workstation. 

1. If you cannot find any installation instructions for the program in the Read Me file or documentation, open ActiveSync and 
click Explore.

2. Navigate to the My Windows Mobile-Based Device folder and copy the program file or files to the Program Files folder on 
the terminal. If you want the program to be part of the Autoinstall that occurs after every hard reset, place the program file in 
the Autoinstall folder (\\IPSM\AutoInstall).

3. On the terminal, tap Start > Programs > File Explorer and navigate to the folder where the program is located.

4. Tap on the program file to install it.
If you copied the file to the Autoinstall folder, you can also choose to install the program by performing a hard reset. The 
program installs as part of initialization. 

5. After installation is complete, access the program by tapping Start > Programs and the program appears on the Programs 
screen. Tap the icon to open the program.

For Additional Help
You can find more information on the host workstation by clicking Help > Microsoft ActiveSync Help.

You can find more information on the terminal by tapping Start > Programs > Help > ActiveSync.

For more information, go to the Windows Mobile software website at:  www.microsoft.com/windowsmobile/products/pocketpc/

http://www.microsoft.com/windowsmobile/products/pocketpc/
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Connections Tab

The Connections Tab of Windows Mobile Settings provides access to the configuration settings for many of the terminal’s 
communication options. Tap Start > Settings > Connections tab.

Note: The programs that appear on the Connections tab depend on the terminal’s radio configuration. 

Program Icon Description

Beam Controls infrared communication.
See Using Infrared Communication on page 7-8.

Connections Accesses Microsoft’s connection manager to set up modem connections.
See Connections Manager on page 7-10.

Network Cards Opens Microsoft’s Network Adapters tool.
See Network Cards on page 7-12.

Radio Manager Enables and disables installed radio drivers.
See Radio Manager on page 7-13.

USB to PC Toggles the terminal between RNDIS USB and Serial USB communication.
Dolphin terminals default to Serial USB.
see USB to PC on page 7-14.
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Connecting the Terminal to a Wireless Network

Establishing the terminal on a wireless network depends heavily on your network infrastructure. You will need specific information 
from your network administrator.

Whatever your network specifics, some general steps apply:

1. The on-board radio drivers must be enabled for the terminal to transmit a signal. Verify the radio’s status in the Radio 
Manager (see page 7-13).

2. Enter the appropriate configuration settings for each radio installed. Each radio has its own configuration program.

• For details about the 802.11g radio, see Wireless LAN Communication with 802.11g on page 8-1.
• For details about Bluetooth radio, see Wireless PAN Communication with Bluetooth on page 9-1.

Connecting the Terminal to an ISP

This method uses an external modem rather than a wireless radio. For instructions, see Proxy Server Connections on page 7-10.

Adding Programs From the Internet

When you have established a network connection (via modem or wireless radio), you can access the Internet and download 
additional software programs.

When selecting programs, verify that the program and version of the program are designed for the Windows Mobile 5.0 and the 
terminal’s processor. 

1. Verify the terminal’s processor by tapping Start > Settings > System tab > About > Version tab. Make a note of the 
information in the Processor field. 

2. Open Pocket Internet Explorer and navigate to the program’s location. You may see a single *.exe or setup.exe file, or 
several versions of files for different device types and processors. 

3. Select the program version that matches the terminal and processor. 

4. Read any installation instructions provided by the program, such as Read Me files or other documentation. Many programs 
provide special installation instructions.

5. Download the program to the terminal straight from the Internet.
You would normally store the program in the \Program Files folder unless another location is required by the program. 

6. On the terminal, tap the installer file, often an*.exe file.

7.  The installation wizard for the program begins. 

8. Follow the directions on the screen to complete installation.

!
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Using Infrared Communication

The IrDA port sends and receives data between the terminal and other devices equipped with infrared. The maximum data 
transfer speed is 115 Kbps with a duty cycle of 18.75%.

IrDA Port Location        

Verify Beam Settings 
By default, the IrDA port is enabled after each hard reset. This means that the IrDA port is ready to send and receive data via 
infrared. Tap Start > Settings > Connections tab > Beam. 

Receive all incoming beams… must be checked for the terminal to receive infrared data from another device.

Sending Data 
You can send and receive information via infrared, including software programs (.exe files).

To send or receive, the IrDA ports of both devices must be aligned with each other and within a close range. The maximum data-
transfer speed is 115 Kbps.

1. Align the IrDA ports of both devices. (When sending data from one Dolphin terminal to another, position both terminals so 
that the IrDA ports are facing each other directly.)

2. Open the program where you created the item you want to send and locate the item in the list.
You can beam files, but not folders, from File Explorer. 

IrDA Port
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3. Tap and hold the item and select Beam File. 

4. The information begins transmitting to the other infrared device.

Receiving Data
1. Verify that the terminal is set to receive all incoming beams; see Verify Beam Settings on page 7-8.

2. Align the IrDA ports.

3. Have the owner of the other device send the information to you via infrared. 

4. Your terminal automatically begins receiving it.

Adding Programs via Infrared
Select a program on one terminal and beam it to another to load additional software programs to Dolphin terminals.

Troubleshooting
If the Beam Settings are not set to receive or you’ve aligned two IrDA ports and the terminal is still not receiving, tap Start > 
Programs > Infrared Receive. The terminal searches for the sending device. 

If the terminal cannot find the sending device, the following message appears:
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Connections Manager

Microsoft’s connection manager sets up various network connections to Internet Service Providers (ISPs) via an external modem.

If you are using one of the on-board wireless radios to connect to a network, do not enter network parameters in the connections 
manager. The Dolphin terminal uses the radio’s settings to connect to the network.

Note: All server-assigned IP addresses use Dynamic Host Configuration Protocol (DHCP). The zero-config Wi-Fi feature of 
Windows Mobile is disabled on Dolphin terminals.

To open the connections manager, tap Start > Settings > Connections tab > Connections icon . The connection 
manager opens displaying the Tasks tab. 

Task Tab
The Task tab enables you to initially configure, then manage network settings when using a modem. Select an item in this list 
and then complete the setup screens that follow with the appropriate information for your network.

My ISP

The links under this heading enables you to add and manage modem connections to an ISP. To complete the setup screens, 
obtain the following information from your ISP:

• ISP dial-up access telephone number 
• Username
• Password 
• TCP/IP settings

My Work Network

These links enable you to establish the following connections types:

• Modem
• Virtual Private Network (VPN)
• Proxy server connection

To complete the setup screens, obtain the network parameters from your system administrator.

Proxy Server Connections

If you are connected to your ISP or private network during synchronization, the terminal should download the proper proxy 
settings during synchronization with the workstation. If these settings are not on your workstation or need to be changed, ask 
your ISP or network administrator for the proxy sever name, server type, port, type of Socks protocol used, and your user name 
and password.
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Modify an Existing Connection

Manage Existing Connections appears on the Connections tab after at least one network connection has been established. 
Tap Manage Existing Connections on this tab and follow the setup screens. You will usually be walked through the same setup 
screens used to establish the connection.

Advanced Tab
The Advanced tab enables you to select the default network, dialing rules, and IP address exceptions for modem connections.

Note: You should not need to change Advanced settings because most ISPs now use DHCP addresses.

Online Help

For more information about modem connection setup, consult the online help on the setup screens by tapping the Help icon .
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Network Cards

The Connections tab (see Connections Tab on page 7-6) contains a Network Cards icon  that displays the network cards 
installed in the terminal.

1. Tap Start > Settings > Connections > Network Cards

2. Tap on an adapter in the list to review its settings. (Server-assigned IP addresses use DHCP.) 

3. If you make a change on one of these tabs, tap OK to confirm the changes. The following message appears:

4. You must perform a soft reset to update the registry entries; see Soft Reset (Warm Boot) on page 3-13. During the soft 
reset, the new registry entries are created and can be read by the applications that need them.

Do NOT perform a Hard Reset (Cold Boot) (see page 3-13) after modifying an adapter here. Hard resets return the terminal 
to factory defaults, which erases network adapter modifications made here. !
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Radio Manager

The Radio Manager enables and disables the radio drivers installed in the terminal. When a radio is enabled, the radio is 
transmitting a signal. When disabled, the radio is not transmitting a signal. 

At least one radio must be enabled before you can set the terminal up on a wireless network. After the radio is enabled, you can 
enter the appropriate network parameters for your network. If the radio is disabled, the terminal doesn’t connect.

Dolphin 7850 terminals are configured with an 802.11g and/or Bluetooth radio.

Radio Driver Installation
For a radio to show up in the Radio Manager, both the hardware module and the software driver for each radio must be installed 
in the terminal. The radio will appear in the Radio Manager if the module is present but cannot be enabled if the associated driver 
is not installed as well. All radios and radio drivers are co-located inside the terminal.

Radio drivers (.cab files) are stored in the Autoinstall folder and install during the Autoinstall process after each hard reset (see 
page 3-13). Only the appropriate drivers for the terminal’s radio configuration install. For more information about Autoinstall, refer 
to the Dolphin Power Tools User’s Guide, which is available for download at www.handheld.com. 

Enabling the Radios 
The terminal enables the 802.11g radio after each hard reset by default. Verify the status of the radio before attempting to 
establish or change network connection settings. 

1. Tap Start > Settings > Connections tab > Radio Manager. 
The Radio Manager appears identifying that radios and radio combinations that can be enabled. 

2. Select the radio or radio combination in the list and tap Apply. The Radio Manager attempts to enable the radio. 

3. When the radio is enabled, the Status field reads “Success.” If an error occurs during a radio mode change, an error 
message appears in the Status field and the change is abandoned; see Radio Manager Window on page 7-13.

Radio Manager Window

To Disable a Radio
To power down all radios, select None and tap Apply. All radios are disabled.

Field Description

Radio Modes Displays the radio hardware modules currently installed on the terminal.

Status Field Provides feedback on the state of the radio. The Status field reads “Ready” when the selected 
radio is enabled and the Radio Manager is ready to receive a command.
Otherwise, the Status field displays the following messages when enabling a radio: 
• Success=The radio or radio combination has been successfully enabled.
• 802.11g error messages=Indicate that the radio could not be enabled.
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USB to PC

The USB to PC applet enables you to switch between RNDIS (Remote Network Driver Interface Specification) USB and Serial 
USB communication. 

Dolphin 7850 terminals default to Serial USB. Hand Held Products recommends using Serial USB.

To change this setting, tap Start > Settings > Connections tab > USB to PC . The enable option is not selected, which 
indicates Serial USB.

To switch to RNDIS USB, select Enable advanced network functionality and tap OK to save. (Wait as the terminal makes the 
change.)
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8
Wireless LAN Communication with 802.11g

Overview

The Dolphin 7850 has an on-board 2.4 GHz 802.11g WLAN (Wireless Local Area Network) radio that uses Direct Sequence 
Spread Spectrum (DSSS) technology. The signal is spread continuously over a wide frequency band at a data rate of up to 11 
Mbps. The radio is interoperable with other 802.11g Wi-Fi-compliant products including Access Points (APs), PCs via PC card 
adapters and other wireless portable devices.

Server-Assigned IP Addresses

Please note that all server-assigned IP addresses use Dynamic Host Configuration Protocol (DHCP).

Zero-Config Wi-Fi

Zero-config Wi-Fi feature of Windows Mobile is disabled on Dolphin terminals.

Enabling the 802.11g Radio
By default, the 802.11g radio is enabled after each hard reset. To verify that the 802.11g radio is transmitting or to disable the 
802.11g, access the Radio Manager (see page 7-13).

Configuring the 802.11g Radio

The Dolphin 7850 contains the Meetinghouse AEGIS Client®, a comprehensive IEEE 802.1X tool to set up the on-board 802.11g 
radio. The Client is a standards-based implementation of IEEE 802.1X and can be configured to work with almost any network 
equipment–wired or wireless–that supports the 802.1X authentication standard. The Client is interoperable with 802.1X-capable 
wireless APs and authentication servers including Microsoft's IAS and Cisco's ACS.

The Client uses public key authentication and encryption between Wireless APs (WAP) and roaming stations to exchange 
dynamic Wired Equivalent Privacy (WEP) keys. In addition, network managers can control 802.1X user profiles from a centralized 
RADIUS server or, in the case of TTLS, from a RADIUS Diameter or other AAA servers. The Client supports both wireless 
(802.11a/b/g) and ethernet interfaces. 

Supported Protocols 

Authentication

The Client supports the following authentication methods according to the 802.1X protocols: 

• MD5 
• EAP TLS
• EAP TTLS
• Cisco LEAP and PEAP
• Microsoft PEAP 

Encryption

The Client supports the following encryptions methods:

• WEP (64-bit and 128-bit)
• TKIP

The Client can also configure the 802.11g radio with no authentication and no encryption; see Associating With Open APs on 
page 8-17.

Required Network Configuration Information
Because the Client accesses a network that is protected by the IEEE 802.1X protocol, you must configure EAP data 
communication to match your network server parameters. If the EAP configuration doesn’t match your network configuration, you 
can’t access the network. Therefore, make sure you have the correct network server parameters on hand when you configure 
the client.
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Opening the Client

Tap the icon in the command bar.

Color Indicators

The color of the icon indicates the status of the controlled ports. 

Icon Color Status

Green Authentication succeeded.

Yellow Authentication is in process.

Red Authentication failed.

If the icon is not yellow, red or green, then either the ports are not being controlled by 802.1x, or there is no authentication 
activity on the controlled ports. The absence of yellow, red or green may also indicate that the network access server is 
not an 802.1x aware device. 

Gray The port is not in use or is disabled. Either the Client isn’t running, or the port is not bound 
to the 802.1x protocol.

Orange The port is associated, but there is no response to 802.11g packets.
If using WEP without 802.1x authentication, this will be the final state when the connection 
is complete. If using 802.1x authentication, it is either a transient condition or can indicate 
that attempts to authenticate have timed out as there was no response to 802.1x packets.

Empty There is no 802.11g activity. The port may not be connected to an 802.1X-aware entity.
If you are setting up the 802.11g radio to run without authentication and without encryption, 
this icon does not change from the standard blue; see Associating With Open APs on page 
8-17.
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Main Window

Double-tap the icon in the command bar to open the Client . The main window opens displaying a list of ports.

Port Status Icon

The main window contains a port status icon to the left of each port. As the network interface starts or stops, the 
color of the port icon and the status field updates to reflect the current state of the interface. The colors of the port 
status icon are the same as the color of the icon in the command bar. For details about what each color means, see 
Color Indicators on page 8-2.

Client Menu

On the main window, tap the Client menu.

Menu Item Description

Close Closes the Client's interface, while leaving the client running. 

Start/Stop Starts or stops 802.1X authentication. After you finish the initial configuration, tap the 
network interface and tap Start. If the port is already active, tap Stop first, then Start 
to force the program to read the new configuration file. 

Restart Same as a Stop followed by Start. Select this menu item when you receive a message 
that a restart is necessary.

Configure Opens the client authentication windows; see Configuring Client Authentication on 
page 8-6. 

Exit Selecting Exit is not recommended. It closes the client and stops the 802.1X protocol. 
A soft reset is required to gain access to the Client again.

Port 
Status 
icon
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View Menu

To access the View menu, tap View. 

Port Menu

The Port menu enables you to configure the port. On the main window, tapping once on a port opens a popup menu.   

Menu Item Description

The Standard and Advanced Views control the number of columns displayed in the main menu.

Standard View Displays the Port (adapter name) and State columns. This is the default view.

Advanced View Displays the Port (adapter name), State, Primary Wireless Network, Wireless Network, 
and MAC Address of AP columns. Scroll right to see all columns.

Event Log Displays the event log in a custom viewer. The Event Log is a text file that contains 
system information; each entry is listed sequentially with a time/date stamp and text 
message. 
Tap Refresh to query the system again and update the log file while you are reading it. 
If the file gets too large, old entries are automatically deleted. 
Logging parameters are set on the System Tab (see page 8-8).

Menu Item Description

Enable 
Disable 

These commands enable or disable 802.1X authentication on the port. The port should 
be enabled before the protocol is started. 

Enabling a port is not the same as starting it (see Start/Stop on page 8-3); however, both 
actions are required for the Client to work. 

Configure Opens the port configuration window; see Configuring a Port on page 8-10.

Delete Selecting Delete has no effect on the Dolphin 7850; you cannot remove the radio driver 
from the device.
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Status Bar

The status bar indicates the connection status between the network card and the AP.

Depending on the status of connectivity, the status bar displays one of the following:

• Not Associated
• AP : [AP's SSID] MAC : [AP's BSSID].

Status Bar
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Setup Windows

Use the following navigation aid to examine the configuration options for each set of configuration windows:

Configuring Client Authentication (see page 8-6)

• User Tab (see page 8-6)
• System Tab (see page 8-8)
• Server Tab (see page 8-9)

Configuring a Port (see page 8-10)

• Wireless Networks Tab (see page 8-10)
• Protocol Tab (see page 8-11)

Configuring a Network Profile (see page 8-13)

• Profile Info Tab (see page 8-13)
• WEP Mgmt Tab (see page 8-15)
• WPA Settings Tab (see page 8-16)

Configuring Client Authentication

Each user account needs to define the protocol and the credentials used to authenticate a user. When you start and stop on a 
port, you are enabling and disabling the authentication established here.

Note: Fields will be grayed out if not relevant to the selected protocol.

On the main window, tap Client menu > Configure. Complete the following tabs:

• User Tab (see page 8-6) to establish user authentication parameters
• System Tab (see page 8-8) to set logging parameters
• Server Tab (see page 8-9) to determine certificate and server parameters

User Tab
Enter the credentials used to authenticate a user.

Field Description

Profile Multiple user credential profiles can be created for use when the user roams from one network to 
another. The drop-down list contains existing authentication credential profiles. Select a profile from the 
list to edit it in the fields that follow.

• Tap Add to create a new profile on the Profile Info Tab (see page 8-13). 
• Enter a Profile name and tap OK. The name entered appears in the this drop-down list.
Tapping Delete deletes the profile selected in the drop-down list. To be deleted, a profile cannot be 
assigned to a configured network.
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Identity This is the 802.1X identity supplied to the authenticator. The identity value can be up to 63 ASCII 
characters and is case-sensitive. 

For tunneled authentication protocols such as TTLS and PEAP, this identity (called the Phase 1 identity) 
is sent outside the protection of the encrypted tunnel. Therefore, it is recommended that this field not 
contain a true identity, but instead the identity “anonymous” and any desired realm (e.g. 
anonymous@myrealm.com). For TTLS and PEAP, true user credentials (Phase 2 identity) are entered 
in the Tunneled authentication section.

When used with PEAP and the .NET Enterprise Server Version 5.2, this field must contain the identity 
used in both Phase I and Phase II. The Phase II identity field is ignored.

Password This is the password used for MD5-Challenge or LEAP authentication. It may contain up to 63 ASCII 
characters and is case-sensitive. Asterisks appear instead of characters for enhanced security.

Authentication 
type

This is the authentication method to be used - MD5-Challenge, LEAP, PEAP, TLS, or TTLS. 

Your network administrator should let you know the protocols supported by the RADIUS server. The 
RADIUS server sits on the network and acts as a central credential repository for Access Servers that 
receive the radio signals and ultimately block or allow users to attach to the network. 

Use certificate This is the certificate to be used during authentication. A certificate is required for TLS, optional for 
TTLS and PEAP, and unused by MD5 and LEAP. Therefore, this option becomes active only when TLS, 
TTLS, or PEAP is selected as the Authentication type.

If Use certificate is enabled, the client certificate displayed in the field is the one that is passed to the 
server for verification. To select a client certificate, tap Change and select the certificate from the list 
that appears. To appear in this list, certificates must be installed in the system; see Certificates on page 
8-18.
The Issued to column should match the Identity field and the user ID on the authentication server used 
by the authenticator. 

Your certificate must be valid with respect to the authentication server. This generally means that the 
authentication server must accept the issuer of your certificate as a Certificate Authority. 

When obtaining a client certificate, do not enable strong private key protection. If you enable strong 
private key protection for a certificate, you will need to enter an access password for the certificate each 
time this certificate is used. 

Tunneled authentication area 

Tunneled authentication parameters are used by only by TLS, TTLS and PEAP protocols, in Phase 2 of authentication, and 
after the secure tunnel has been established. The fields in this section are active only if the TLS, TTLS, or PEAP is selected 
as the Authentication type. 

Identity The user identity used in Phase 2 authentication. The identity specified may contain up to 63 ASCII 
characters, is case-sensitive and takes the form of a Network Access Identifier, consisting of <name of 
the user>@<user’s home realm>. The user’s home realm is optional and indicates the domain to which 
the tunneled transaction is to be routed.

Because Microsoft .NET Enterprise Server Version 5.2 does not use this parameter for PEAP, This field 
will have no effect for PEAP at this time. Phase 1 identity is used instead.

Password The password used for the tunneled authentication protocol specified. It may contain up to 63 ASCII 
characters and is case-sensitive. Asterisks appear instead of characters for enhanced security.

Field Description
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System Tab
Define logging settings and the port manager timeout period.

Protocol This parameter specifies the authentication protocol operating within the secure tunnel. 

The following protocols are currently supported for TTLS: 
• EAP-MD5
• CHAP 
• PAP
• MS-CHAP
• MS-CHAP-V2
The following protocols are currently supported for PEAP: 

• EAP-MS-CHAP-V2
• TLS/SmartCard
• Generic Token Card (EAP-GTC)

Field Description

Log Level These settings control the detail of the log messages generated by the Client. Each level is 
cumulative. By default, all errors, warnings, and information events are logged. Each entry records a 
severity code (of one [debug message] to four [error] asterisks), a time stamp, and a message.

• Errors=Only the most severe conditions are logged.
• Warnings=Less severe conditions are logged.
• Information=All errors, warnings, and information events are logged. This is the default setting.
• Debugging=Creates a log message each time the Client detects or reacts to an event. Be advised 

that log entries fill memory quickly if the Debugging level is chosen. Do not use the Debugging 
option for a significant length of time because most internal operations generate messages.

For more information, see Logging on page 8-9.

Defaults button Tap this button to return log settings to the default settings.

Scan List 
Timeout

The time interval at which the Client polls the ports. This value should not be changed from the 10-
second default unless technical support advises you to do so.

Save Credentials 
for (min)

The amount of time the Client saves credentials.

Disable Wireless 
Zero Config

This option is selected by default and disables other wireless utilities.

Use this option only as directed by technical support. 

Field Description



Dolphin® 7850 Series User’s Guide–
Preliminary

Rev (b)
5/15/2007

8 - 9

Logging

The event log is an ASCII text file named “LOG8021X.TXT” located in the directory defined by the WINDIR environment variable 
(usually the Windows directory). 

In the text file, the format of the entries is: 

Time Stamp Message Text

Note: To see an event log on the window, tap View > Event Log (see page 8-4). 

If you wish to start with a blank file or clear the event log, close the Client (so that the icon no longer appears in the command 
bar) and delete the log file (log8021x) in WIndows Explorer. When you restart the Client, a new log file is created.

Server Tab
The Server tab controls how the Client authenticates the server that handles the 802.1X protocol on the network side. This 
applies only to the TLS, TTLS, and PEAP authentication methods and is used to tell the Client what server credentials to accept 
from the authentication server to verify the server. The Client uses this information to verify that the Client is communicating with 
a trusted server.    

Field Description

Do not validate server 
certificate chain

If this option is selected, the server certificate received during the TLS/TTLS/PEAP message 
exchange is not validated.

*Certificate issuer 
must be 

This is the certificate authority used during TLS/TTLS/PEAP message exchange. Any Trusted 
CA is the default selection and means that any certificate authority can be used during 
authentication.

Both trusted intermediate certificate authorities and root authorities whose certificates exist in 
the system store are available for selection in the drop-down list. 

*Allow intermediate 
certificates

This option is selected by default and enables unspecified certificates to be in the server 
certificate chain between the server certificate and the certificate authority selected in the 
Certificate issuer must be field. 

When selected, this option allows the server certificate received during negotiation to be issued 
directly by the certificate authority or by one of its intermediate certificate authorities. 

If disabled, then the selected Certificate issuer must have directly issued the server certificate.

Server name must be This is either the server name or the domain the server belongs to, depending on which option 
is selected below the text field.

During authentication, this name will be compared to the server certificate’s Subject: CN field.

Must match exactly The server name entered must match the server name found on the certificate exactly.

Must contain domain 
name

The server name field identifies a domain and the certificate must have a server name 
belonging to this domain or to one of its sub-domains (e.g., zeelans.com, where the server is 
blueberry.zeelans.com).
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Configuring a Port

On the main window, tap on a port and tap Configure. Complete the Wireless Networks Tab (see page 8-10) and the Protocol 
Tab (see page 8-11).

Wireless Networks Tab

*In order to function properly, certificates must be recognized by both the Client and the operating system. For more 
information, see Certificates on page 8-18.

Field Description

Available Networks   Displays the networks the device recognizes as available to connect to.

Move to Configured Activates after the available networks have been retrieved. Select the network you wish to 
connect to, and tap Move to Configured. This selects the network and moves it to the Configured 
Networks list.

Refresh Displays a list of networks broadcasting their availability. 
You can also attach to networks that are not broadcasting.

Configured Networks   Displays the configured network profiles saved in the device. The order of the network profiles in 
this list is the same order (from the top down) that the device uses to connect to a network.

default This is the default network configuration that installs when the Client installs. This network profile 
associates with any network and is already configured with standard settings. You can modify 
this setting to match your desired connection. 

If you are in a location with only one AP (or more than one AP that attaches to the same 
network), the default profile may be sufficient without requiring the selection of a specific network 
or networks. 

If default is last in the list, it can act as a wildcard if the device is out of range of the primary 
networks (listed first). 
Do NOT place default at the top or middle of the list if you are connecting to other networks! If 
default is any place other than last, connection to the other list entries is never attempted.

Note: Note that there is nothing special about the name "default". You could configure any other 
record similarly and it would behave the same way.

Up & Down Moves a selected network up or down one place in the list.The order of the networks in this list is 
the exact order that connections will be attempted. The network listed first will be attempted first 
and so on. Place your primary networks first.

Field Description
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Protocol Tab
The Protocol tab configures parameters that apply to all the networks the selected port connects to.

Add Manually adds a network to the Configured Networks list. 

Manually add a network if the AP does not broadcast its SSID or you are pre-configuring the 
client for an AP that is not currently in range. 
For details, see Configuring a Network Profile on page 8-13.

Remove Removes a selected network from the Configured Networks list.

Properties Displays the properties of the network selected in the list. Tap this button to edit existing wireless 
network configurations.

For details, see Configuring a Network Profile on page 8-13.

Field Description

Protocol Settings These are the timer intervals and retry settings defined in the 802.1x standard. They determine how 
long the supplicant state machine will wait in a given state. These parameters shouldn’t be modified 
without an understanding of the supplicant state machine. For more information about the supplicant 
state machine, obtain its 802.11x protocol specification. 

The parameters are:

• Authentication Timeout=The period of time the Client remains in the authenticating or acquired 
state without receiving a response from the AP or switch. 30 seconds is the default.

• Held Timeout=The period of time the Client remains in the held state after failing authentication. 
60 seconds is the default. 

• Start Timeout=The period of time the Client remains in the connecting state before restarting when 
there is no response. One second is the default. 

• Number of Start Attempts=The number of times the Client restarts before giving up. At that point, 
the Client then defaults to the authenticated state, but there will be no network connectivity because 
the protocol exchange was never completed. Three is the default.

Display EAP 
notifications

Specifies that the EAPOL notification message will be displayed to the user. An authenticator may 
use such notification to inform you, for example, about a near password expiration. However, some 
authenticators send chatty and annoying notifications that may, for the convenience of the user, be 
suppressed. Note that all notifications are written to the event log even if they are not displayed.

Field Description
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Renew IP address Initiates a DHCP request to obtain a dynamic IP address after a successful authentication, but only if 
the client detects that the connected network (the SSID) has changed. The result is that renewal 
should not occur upon re-authentication, but does occur at boot or when connecting to a different 
network. 
If you have a slow authenticator, you may wish to enable this option when configuring the service 
because a slow authenticator may prevent you from getting a DHCP-assigned IP address upon boot-
up. This option is ignored if the given adapter has a static IP address.

Field Description
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Configuring a Network Profile

You can configure a network based on an AP in range, create a new network, or modify the default (see page 8-10) network. The 
default network comes pre-configured with the Client.

To configure a network to an AP in range, tap one of the networks in the Configured Networks list. Select the network and tap 
Properties. 

The Profile Setup tab windows open. 

Note: If the AP you want is not in the Configured Networks list, select it in the Available Networks list and tap Move to Configured. 
To create a new network, tap Add. 

There are three tabs to complete:

• Profile Info Tab on page 8-13
• WEP Mgmt Tab on page 8-15
• WPA Settings Tab on page 8-16

Information from the AP autofills some fields on these tabs. 

Note: The settings on these tab windows are interrelated. This means that selecting one may disable access to others.

Profile Info Tab  

Field Description

Network Profile If you are configuring a network from the list, the name that appears in this field is the same as the 
name in the Configured Networks list and, by default, is the same as the broadcast SSID. This name 
cannot be changed.

If you are adding a new network, this field is configurable.

Network Name This is the SSID of the AP. If the AP broadcasts its SSID, then this value is retrieved from the Available 
Networks list and this field is completed automatically. If the SSID does not broadcast, then the field will 
be active and you must manually enter the value here.

Note: You cannot enter a Network Name if Associate with any available network is enabled.
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Peer-to-Peer 
Group 

Select this option to have two or more client workstations communicate with each other without the 
benefit of an AP, otherwise known as ad hoc mode. 

You should also select Do Active Scan and, on the WEP Mgmt tab, select Use key for data 
encryption while entering a common key for both sides. WPA is not supported in this mode.

Associate with 
any available 
network

Select to associate with any available network.

Do active scan Select this option whenever the AP (or client, for ad hoc mode) is not broadcasting its SSID. 

Note: This option is not available when Associate with any available network is selected.

Authentication 
Profile 

Select the authentication profile associated with this network and tap View. The drop-down list contains 
client profile names created in the User tab of the client configuration area; see User Tab on page 8-6.

default is the default authentication profile.

Field Description
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WEP Mgmt Tab
Enter the appropriate WEP parameters for the network.

Field Description

Provide encryption 
key dynamically

This option is selected by default. The other WEP settings on this page are disabled to enable 
dynamic encryption. Selecting this option also enables WPA; the WPA Settings tab appears. 

To enter a custom WEP, de-select this option. The other fields become active and the WPA 
Settings tab no longer appears.

Use key for data 
encryption

Select this option to manually enter a WEP key (in the Key field) to encrypt your data to the AP.

Use key to 
authenticate with AP

Selecting this option toggles the WEP authentication mode between Open and Shared (Not 
checked = Open, checked = Shared). 
• Open means the only authentication performed is to check that a client's SSID setting matches 

the SSID of the AP.
• Shared means that the Client authenticates with the AP via a challenge/response mechanism. 

Key In this field, enter the WEP key to use for data encryption or authentication to the AP.

ASCII: 5 or 13 characters
Hexadecimal: 10 or 26 characters.

When the key entered is in the correct format, the window changes to display the type–ASCII or 
Hexadecimal. 

Key Index/Transmit 
Key

This list contains the available keys. You may enter up to four keys for reception; the Client will 
try all four to find one that works with the AP.

Select the key to be used for transmission as well. If the key selected is the transmit key, the 
Transmit key box is checked. 

To change the transmit key, select another key and check the Transmit key box. The check box 
of the original transmit key will be automatically de-selected.



8 - 16 Rev (b)
5/15/2007

Dolphin® 7850 Series User’s
Guide–Preliminary

WPA Settings Tab
This tab controls the WPA settings. This tab window is available only if Provide encryption key dynamically is selected on the 
WEP Mgmt tab is selected.

Field Description

WPA Mode This drop-down list contains the following options:
• Disabled:  Do not enable WPA mode. This is the default selection.
• WPA 802.1x:  Enable WPA and obtain key information through the 802.1x protocol. 
• WPA PSK:  Enable WPA with Pre-Shared Key (PSK) information entered in the field below. 

This mode is used if the 802.1x protocol is not being used for authentication.

Encryption Select the desired encryption.

• WEP: The least secure of the encryption methods. WEP uses a single encryption key of either 
40 or 104 bits. WPA uses a 256 bit Pre-shared key.

• TKIP: Uses the standard WEP format, but changes the key with every frame for improved 
security and includes a message integrity capability for determining unauthorized packet 
insertion.

Note: The current Dolphin 7850 hardware does not support AES.

PSK pass-phrase This field activates if you select WPA PSK as the mode. This must be 8–63 ASCII characters or 
64 hexadecimal digits.
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WEP Encryption Without Authentication

1. On the Main Window (see page 8-3), tap the port and select Configure on the popup menu.

2. On the Wireless Networks Tab (see page 8-10), select the SSID and tap Properties.

3. On the Profile Info Tab (see page 8-13), select Do active scan. 

4. On the WEP Mgmt Tab (see page 8-15), select Use key for data encryption.

5. Enter the WEP Key; see Key on page 8-15. Tap OK.

6. On the main window, tap Client > Restart to restart the Client. 

7. Wait as the Client connects. 

8. When the connection is complete, the Port Status Icon (see page 8-3) on the main window reads Associated instead of 
Authenticated. However, the log file (see Logging on page 8-9) will read “Entered AUTHENTICATED state” when recording 
this event.

Associating With Open APs

To associate with open APs means to set up the 802.11g radio without authentication or encryption. 

1. Double-tap the Client icon on the command bar .

2. On the Main Window (see page 8-3), tap on the port and select Configure on the popup menu.

3. On the Wireless Networks Tab (see page 8-10), tap Add in the Configured Networks section. 

4. On the Profile Info Tab (see page 8-13), enter your AP's SSID in the Network Profile field.

5. Select default in the Authentication profile drop-down list. 

6. On the WEP Mgmt Tab (see page 8-15), make sure none of the options are selected.

7. Tap OK on the Wireless Networks tab.

8. On the Main Window (see page 8-3), tap Client > Restart to restart the client.

9. Wait as the Client connects.

10. When connection is complete, the Port Status Icon (see page 8-3) turns yellow and the Status Bar (see page 8-5) reads 
“Associated”.

Note: If your AP is strictly an AP and not a DHCP server, then you must statically assign an IP address and subnet mask.
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Certificates 

On the Server Tab (see page 8-9), you can specify one or two certificates to use during the authentication process.

Certificate Requirements 

The specified identity should match the Issued to field in the certificate and should be registered on the authentication server 
(i.e., a RADIUS server) that is used by the authenticator. In addition, your certificate must be valid on the authentication server. 
This requirement depends on the authentication server and generally means that the authentication server must know the issuer 
of your certificate as a trusted Certificate Authority (CA). 

If the selected certificate does require a password or pass phrase to decode the private key, enter this value in the Certificate 
Pass Phrase field. This value will be encrypted when the configuration is saved. However, on some systems, there may not be 
a certificate. 

Note: Client or CA certificates can be imported from *.cer (same as *.der), *.p7b, or *.pfx files.

Installing Certificates with CertAdd
CertAdd is a separate utility that allows certificates to be selected and installed on the device for the Meetinghouse Client.   

1. Download the certificate file to the device.
The location isn’t critical, but you may want to create a standard folder for consistency.

2. Tap Start > Programs > Meetinghouse Certificate Installer. 

3. Navigate to the certificate location. 

4. Tap and hold on the certificate. A popup appears asking if you want to install the certificate.

5. Tap OK. The certificate is loaded into the correct certificate store. 

6. Verify that the operating system recognizes the certificate. Tap Start > Settings > System tab > Certificates  > 
Root tab and find the certificate in the list.
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Installing a Root Certificate
Save the certificate to the device. If no error appears when you save the certificate, it was most likely saved to the device. To 
make sure that the certificate persists through cold boots, install the certificate to the \IPSM folder.

1. To verify that the certificate is recognized by the operating system, tap Start > Settings > System tab > Certificates 

 > Root tab. This opens the Certificates window, which displays all the certificates the operating system recognizes.

1. Scroll through this list until you see the certificate you installed.   

2. After you have identified your certificate in the list, tap OK to close.

3. To use the certificate in a network profile, single-tap the Client icon in the command bar .

4. Tap on a port on the main window and select Configure.

5. Tap the Server tab and select the certificate from the Certificate issuer must be drop-down list. 

6. Tap OK to save the setting and close the port configuration. 
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Advice and Workarounds

Issue Possible Causes and Solutions

The Client will not start on the device with an 
error message about missing files.

Perform a soft reset.

The wireless network interface (port) does not 
appear in the main AEGIS window.

• The license is not valid.
• Restart the client: on the main window tap Client > Restart.
• Perform a soft reset.
• If problem continues to persist through all of the above, there may be 

a hardware failure.

The Client is not attaching to the correct AP. The default network profile instructs the client to attach to the first 
available AP. You must select a network, move it to the Configured 
Networks list, and then move it above default in the list using the up 
arrow buttons.
For more information, see Wireless Networks Tab on page 8-10.

The Client is failing authentication even though 
all my information was entered correctly.

1. Verify that the network profile for the AP corresponds to the 
authentication profile you created for it: 

• Select the network profile in the Configured Networks list.
• Tap Properties. The Profile Info tab opens - see page 8-

13.
• In the Authentication profiles drop-down list, select the 

profile you want to review.
• Tap View. The User tab appears displaying the profile’s 

information.
2. Verify that you have configured the identity and password into the 

correct fields on the User tab (page 8-13) in the authentication 
profile. If you are using PEAP or TTLS, the username and password 
are entered in the Tunneled authentication section.

My AP does not broadcast its SSID. Even 
though I have manually configured an AP with 
that name, the Client won't associate with it.

• Make sure that the Network Name field contains the AP’s SSID.
• Verify that Do Active Scan is selected on the Profile Info tab; see Do 

active scan on page 8-14. Otherwise, the Client will not attempt to find 
the AP.

I am authenticated, but I don't get an IP 
address through DHCP.

• On the main window, tap on the port, tap Configure on the popup 
menu, and select the Protocol tab. Verify that Renew IP Address is 
selected; see page 8-12.

• Make sure that the 802.11g radio is configured for DHCP and not 
assigned a static IP address. 

I cannot attach to my old network that does not 
support 802.1x authentication, but is using 
WEP encryption.

• On the Wireless Networks Tab (see page 8-10), verify that the desired 
SSID is at the top of the Configured Networks list so that it’s accessed 
first.

• See WEP Encryption Without Authentication on page 8-17. 

I made changes, but they do not appear to have 
taken effect. 

Always tap OK before exiting a window you have changed. 
Then, on the main window, tap Client > Restart to restart the Client.

How do I enable peer-to-peer (ad-hoc) mode to 
have two clients communicate without an AP?

• On the Wireless Networks window, move a network to the Configured 
Network list. 

• On the Profile Info tab, give each side the same network name (SSID). 
• Select Peer-to-Peer Group (ad hoc mode) and Do active scan. 
• On the WEP management section, select Use key for data 

encryption and enter an identical key for both clients. 
• Verify that this network profile is the first (or only) one in the 

Configured Network list and try to restart both clients at roughly the 
same time.
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Wireless PAN Communication with Bluetooth
Bluetooth Radio

The on-board Bluetooth radio is enabled by default at startup and operates within the 2.4 GHz–2.48 GHz band. Bluetooth 
transmissions hop between 79 separate frequencies 1,600 times every second, and with a communication range of about 10 
meters (class II). 

BTExplorer

BTExplorer discovers Bluetooth devices in the vicinity and presents them in an easy-to-understand format similar to Windows 
Explorer. BTExplorer visually separates trusted (paired) and untrusted remote devices and identifies friendly names and services 
of remote devices. Custom icons indicate the device class (type) as well as available services.

The services supported by the local device include 

• OBEX
• File transfer
• OBEX object push
• Dial-up networking
• FAX
• LAN access
• Serial port communication

Pairing, security, and encryption settings can be configured for the local device. In addition to the configuration options available, 
any of the supported services may be added to or removed from the local device.

Enabling the Bluetooth Radio

The Bluetooth radio must be enabled in order to connect to other devices.

By default, the 802.11b radio is enabled after each hard reset. Therefore, you must enable the Bluetooth radio in the Radio 
Manager (see page 7-13). Tap Start > Settings > Connections tab > Radio Manager and select Bluetooth Only or 802.11b/
Bluetooth and OK.

Accessing BTExplorer

When the radio is enabled, the Bluetooth icon appear in the command bar of the Today screen . Tap this icon to access the 
popup menu and select Show BTExplorer. 
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Using BTExplorer

BTExplorer has a New Connection Wizard for each type of Bluetooth connection you want to make; see Connection Types on 
page 9-3. You open BTExplorer, select the connection type, BTExplorer scans for matching devices and services, and the 
connection wizard walks you through the connection process. 

Different connection types will require different information. Make sure you have all the necessary information (PIN numbers, 
passkeys, MAC addresses, etc.) from the devices you want to connect to.

1. On the Today screen, tap the Bluetooth icon  and select Show BTExplorer. The Connection Wizard opens.

2. Select the action you would like to perform in the drop down list and click Next.
BTExplorer scans for other Bluetooth devices in range and displays the search results.

3. Select a device and click Next.

4. Depending on the item selected on the New Connection window, you’ll be asked to enter specific information in the setup 
wizard. 

5. Complete the wizard to setup the connection type selected; see Connection Types on page 9-3.

Navigation Buttons
Bluetooth Explorer contains the following navigation buttons at the bottom of ever wizard screen:

Back Move back on screen in the wizard.

Cancel Cancel the setup and return to the New Connection window. 
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Next Save the information on the current setup screen and move to the next.

Connection Types

Bluetooth Explorer performs the following connections:

Connection Type Allows the Dolphin terminal to… Requirements

Explore Services on Remote 
Devices

Discover available services.

Pair with Remote Device Pair with remote devices The correct PIN number of the device 
you’re attempting to pair with.

ActiveSync via Bluetooth Synchronize files and data with a remote 
workstation via Bluetooth ActiveSync.

Matching Bluetooth ActiveSync settings.

Browse Files on Remote Device See files on a remote device A working Bluetooth connection with the 
remote device.

Connect to Internet using 
Access Point

Connect to the Internet using LAN or a 
network gateway.

A Bluetooth-compatible access point.

Connect to Internet using Phone/
Modem

Connect to the Interne using a mobile 
phone or mobile phone modem using 
dial-up networking. 

Dial-up account information.

Connect to Personal Area 
Network (PAN)

Connect to another Bluetooth device that 
allows participation in a PAN.

Another device that is set up as part of 
an existing PAN.

Send or Exchange Objects Send or exchange business cards, 
contacts, pictures, appointments, and 
tasks with another Bluetooth device.

A working Bluetooth connection to a 
remote device.

Associate Serial Port Make a favorite to a Bluetooth serial port 
device.
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Device Types

BTExplorer supports the following device types:

• Audio Devices
• Network Devices
• Phones
• Printers
• Computers
• OBEX Devices

By default, BTExplorer scans for Network Devices. 

To change the, device type, tap on the arrow to the right of the heading on the left. The name of this heading changes depending 
on what device type is selected; it can say “Filter” or “Bluetooth Devices.” 

Select another device type in the list.

View Options

Discovered Devices appear with an icon indicating what type of device it is and the Device ID.

By default, the discovered devices screen appears in the Large icon view. The Details menu offers you alternate view options.   
(When you select the Details menu, its name changes to “View.”) 

Large Icons Displays large icons in the viewing area.

List Displays small icons in a one-column list.

Details Displays small icons in a list with two columns

Remote Device NameThe Device ID

Device AddressThe MAC address

TrustedThe status of this device; False means the device is not trusted.
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Menu Options

The discovered devices window has a popup menu that enables you to perform several tasks. You can select a device and tap 
and hold or just tap and hold on an empty space; he same menu appears. Certain menu items are enabled or disabled depending 
on which method you use.   

Menu Item Description

Discover Devices Scans for Bluetooth devices.

Discover Names Scans for device names.

View Opens a side menu that offers you sorting options for the 
discovered devices list.
• All Devices–Shows all devices in the vicinity.
• Trusted Devices Only–Removes untrusted devices 

from the display.
• Untrusted Devices Only–Removes trusted devices 

from the display.

Note: These options affect only what appears on the 
display, not what devices the Dolphin terminal has 
discovered.

Delete All Devices Deletes all the discovered devices.

*Delete Device Deletes a selected device.
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Refreshing Discovered Devices

If your Bluetooth device doesn’t show up in the list, scan again by tapping and holding on the window and selecting Refresh on 
the pop-up menu. 

Note: BTExplorer displays the devices found on the first search but does not refresh automatically.

Pairing

Pairing associates Bluetooth devices with each other so that you don’t have to enter access information every time a connection 
is requested. Bluetooth devices need to be paired with each other before attempting a connection the first time. 

Paired devices remain paired, even if: 

• One of the devices is not powered. 
• A service connection is interrupted or stopped. 
• One or both devices are rebooted. 

Passkey Paired devices share a unique passkey both devices use to authenticate when connecting. The 
passkey can be alphanumeric, numbers, or letters, and must consist of one or up to 16 characters. 

*Properties Displays the properties of a selected device.
Tap OK (either one) to return to the discovered devices 
window.

Refresh Scans for Bluetooth devices.

*These items are active only when a device is selected when the pop-up menu appears.

Menu Item Description
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10
Dolphin HomeBase

Overview

As the hub of your Dolphin 7850 system, the Dolphin HomeBase charging and communication cradle supports both RS-232 and 
USB communication, enabling your terminal to interface with the majority of PC-based enterprise systems. 

Communication
RS-232 transmits data at speeds of up to 115 Kbps. With USB port, the data transmission rate goes up to 12 Mbps. 

HomeBases cannot be physically connected to each other–sometimes referred to as “daisy-chaining”–but can be networked 
together through serial or USB hubs.

Convenient Storage 
Intelligent battery charging makes the HomeBase a safe and convenient storage receptacle for your terminal. 

Capacity
The HomeBase can charge two battery packs: the one that’s installed in the terminal and the other in the auxiliary battery well 
on the back panel. While charging the battery pack in the terminal, the HomeBase also powers the Dolphin terminal. The auxiliary 
battery well charges a battery pack independently of the terminal well. 

Intelligent Battery Charging
The HomeBase completes a full charge of the main battery pack in less than four hours. 

In addition to charging, the HomeBase powers the intelligent battery charging system in the terminal that protects the battery 
from being damaged by overcharging. The terminal senses when a battery pack is fully charged and automatically switches to a 
trickle charge that maintains the battery at full capacity. 

As a result, terminals may be stored in the HomeBase without damage to the terminals, battery packs, or peripherals. 

Power Supply
The HomeBase is available with US, UK, and European power supplies. Each version is designed to convert the voltage from 
the power sources in each geography to the 7.4 volts DC required by the terminal.

Use only the peripherals, power cables, and power adapters from Hand Held Products. Use of peripherals, cables, or power 
adapters not sold/manufactured by Hand Held Products will void the warranty and may damage the terminal.

Use only the Li-ion battery packs provided by Hand Held Products. The use of any battery pack not sold/manufactured by Hand 
Held Products in a Dolphin terminal will void your warranty and may result in damage to the Dolphin terminal or battery.

!

!



10 - 2 Rev (b)
5/15/2007

Dolphin® 7850 Series User’s
Guide–Preliminary

Front Panel 

AUX Battery LED

Indicates status of the battery charging in the auxiliary battery well; see page 10-3. 

Orange The auxiliary battery is charging.
Green The auxiliary battery has completed charging and is ready for use.

COMM LED

The COMM LED indicates the status of data transfer between the Dolphin terminal and the host workstation. The 
color of this LED differs if the HomeBase is using the serial or USB port connection.

If using a serial port connection

Red Serial data is being sent from the host device to the HomeBase. 
Green Serial data is being sent from the HomeBase to the host device.
Orange Serial data is being sent at high data rates.

If using a USB port connection
Green A USB connection is established with the host workstation.

DOCK LED

Turns solid green when the terminal is properly seated in the HomeBase. When this light is on, the terminal is 
connected to the HomeBase.

Terminal Well

Place the terminal in this well to communicate with a host device, power the terminal, and charge its battery pack. 
The back of the terminal well features a saddle to accommodate the integrated pistol-grip handle. 

DOCK COMMA UX B ATTE R Y

AUX Battery LED

DOCK LED AUX Battery LED COMM LED
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Back Panel 

Auxiliary Battery Well 

The auxiliary battery well charges an additional Li-ion battery pack independently of the terminal well. This feature 
ensures that you can always have a fully-charged battery for your terminal; see Charging a Spare Battery Pack on 
page 10-3.

DC Power Jack 

Connect the power cable to this power jack; see Powering the HomeBase on page 10-5.

Handle Saddle

The curve on the back wall of the terminal well accommodates the pistol-grip handle when the terminal is seated in 
the well. 

RS-232 Port 

For RS-232 data communication, use the 9-pin, RS-232 cable from Hand Held Products to connect this port to a 
peripheral device. For more information, see RS-232 Serial Connector on page 10-5.

USB Port

This USB Port is full-speed, 2.0 compliant, and requires ActiveSync 4.1 or higher. Using a USB cable, you can 
connect the HomeBase to a USB-compliant device. When the HomeBase is connected to that device, the terminal 
is connected to the device when seated in the terminal well. The HomeBase acts as a USB device by interfacing 
the USB signals of the terminal to the USB signals of the host workstation; see ActiveSync Communication on page 
10-7.

Charging a Spare Battery Pack
The auxiliary battery well located on the back panel (Auxiliary Battery Well, page 10-3) charges a spare battery. The AUX Battery 
LED (page 10-2) on the front panel indicates the charge status of the battery in this well. Charge time is less than four hours and 
the charge process is independent of the terminal well. 

1. Insert the end of the battery without the locking tab into the bottom of the auxiliary well opening.

2. Snap the battery into place with a hinging motion. The Aux Battery LED lights orange.

3. The AUX Battery LED monitors the charge progress.

Auxiliary 
Battery 
Well

DC Power 
Jack

RS-232 Port USB Port

Handle Saddle
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Bottom Panel Dimensions

136.3 mm.
(5.37 in.)

78 mm.
(3.1 in.)

162.2 mm.
(6.4 in.)
106 mm.
(4.2 in.)

108 mm.
(4.25 in.)

62 mm.
(2.4 in.)
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Powering the HomeBase

The terminal requires 9.5 volts DC input for communication and battery charging; the power adapter on the power cable converts 
the voltage from the power source to 9.5 volts DC. Only power adapter cables from Hand Held Products convert the voltage 
appropriately.

1. Plug the power cable into the power adapter.

2. Plug the power cable into the power source.

3. Plug the connector cable into the DC power jack on the back panel. The HomeBase is now powered. 

When a terminal is properly seated in the terminal well, the HomeBase powers the terminal, charges the terminal’s main battery 
pack, and launches ActiveSync communication (see ActiveSync Communication on page 10-7).

Hand Held Products recommends that you leave the HomeBase connected to its power source at all times, so that it is always 
ready to use.

RS-232 Serial Connector
The following diagram displays the pins of the RS-232 serial connector of the Back Panel (see page 10-3): 

Note: Signals referenced are for a DTE device. The HomeBase is at a right-angle to the printed circuit board (PCB). The ninth 
pin has a ring indicator (RI).

Plug this connector into the 
DC Power Jack on the back 
panel.

Power Adapter

Power Cable
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Charging the Main Battery

The HomeBase powers the terminal and fully charges its main battery pack in less than four hours. To check battery power, see 
Power on page 6-11. 

As battery packs charge, the charging circuitry follows the two-step charging process (CC-CV) that is recommended for Li-Ion 
batteries. The process monitors changes in temperature, current, and voltage.

Inserting a Terminal
1. Install the battery pack in the terminal; see Install the Main Battery Pack on 

page 2-1.

2. Power the HomeBase; see Powering the HomeBase on page 10-5.

3. Slide the terminal into the terminal well until the Dock LED lights green to 
indicate that the terminal is properly seated.

4. The battery pack begins charging. 

The intelligent battery charging system in the terminal monitors battery power and 
senses when a full charge has been obtained. When charging is complete, the 
terminal switches to a trickle charge that keeps the battery at full charge while resting 
in the HomeBase.
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ActiveSync Communication

The Dolphin terminal ships with ActiveSync already installed and defaulted to USB communication. If ActiveSync is not installed 
on your workstation, you must install it. For details, see Using ActiveSync on page 7-3.

Communication Types
The HomeBase can communicate via USB or RS-232 using ActiveSync 4.1 or higher. However, the HomeBase should have only 
one type of interface cable connected at a time, either USB or RS-232.

USB The USB Port (see page 10-3) on the back panel allows the terminal to communicate with a 
workstation or be networked through a USB hub. The HomeBase acts as a USB device by interfacing 
the USB signals of the terminal to the USB signals of the host workstation. 

Maximum data transfer rate is 12 Mbps.

RS-232 The RS-232 Port (see page 10-3) on the back panel allows the terminal to communicate with a 
workstation, modem, or any RS-232 device using a standard serial cable and communication 
software.

Maximum data transfer rate is 115 Kbps.

Communicating with the Dolphin Terminal
1. Insert the terminal into the terminal well of the HomeBase. 

• The DOCK LED lights green. 
If not, make sure that the terminal is properly seated. You may need to remove and re-insert the terminal.

• The terminal activates. 
If not, verify that the Hand Held Products power supply is properly connected to the DC Power Jack (see page 10-
3) on the back panel and plugged into a functioning outlet.

2. The terminal and the workstation automatically open ActiveSync to establish a connection.

3. The HomeBase can now transfer data between the terminal and the host workstation. If communication does not occur, 
check the port connections to ensure that the cradle is correctly configured. 

Verify Communication

You can verify that the USB driver is functioning by watching the COMM LED on the USB HomeBase. When the 
COMM LED lights solid green, the Dolphin HomeBase is communicating with the workstation.

Verify Data Transfer

The COMM LED flashes when data is being transferred via the Dolphin HomeBase. For an RS-232 connection, the 
COMM LED flashes red and green. For a USB connection, the COMM LED flashes green.
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RS-232 Cables

Connect the HomeBase to the host workstation or other device by plugging an RS-232 serial cable into the RS-232 Port (see 
page 10-3) on the back panel. The wiring of your cable depends on whether the other device is set up as a Data Communication 
Equipment (DCE) or Data Terminal Equipment (DTE) device. 

The HomeBase is configured as a DCE device. To communicate with another DCE device, use either a null modem adapter in 
line with a standard RS-232 cable, or a null-modem serial cable. To communicate with a DTE device such as a computer, use a 
standard (or straight-through) RS-232 cable. 

You can make your own cables by following the pin configuration in the chart below. To do so, you must determine if your host 
RS-232 device is 9-pin or 25-pin, and whether it is configured as a DCE or DTE device.

RS-232 Pin Configuration

Note: The HomeBase cannot be daisy-chained.

HomeBase /Host Port (DCE) IBM AT DB9 (DTE) IBM XT DB25 (DTE) Modem DB25 (DCE)

Pin / Input Signal

2   / (RD) 2 3 2

3   / (TD) 3 2 3

5   / (SG) 5 7 7

4   / (DTR) 4 20 6

6   / (DSR) 6 6 20

7   / (RTS) 7 4 5

8   / (CTS) 8 5 4
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Mounting the Dolphin HomeBase

Set the HomeBase on a dry, stable surface, such as a desktop or workbench near an electrical outlet. Be sure to provide enough 
workspace with good lighting for the user to view and operate the terminal while it is seated in the HomeBase.

When choosing a location, bear in mind that: 

• the mounting location must allow users easy access to the auxiliary battery well, and
• the serial and USB ports as well as the power jack face straight out of the rear panel, and you will most likely want easy access 

to them in the future.

Desk Mounting
Dolphin charging/communication cradles have a DIN rail (7.5 mm high X 35 mm wide) slot on the bottom to allow for secure desk 
attachment of the unit if desired.   

1. Slide the DIN rail slot along the bottom panel. 

2. Using the appropriate nuts and bolts, secure the DIN rail to the desk or flat surface. 

Note: Use screws that are appropriate for the type of surface (wood or metal, for instance) you are mounting to. 
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Wall Mounting
A wall mount kit that contains a screws and a mounting bracket can be purchased separately. The bottom panel of the HomeBase 
contains four rubber feet–one at each corner–that help keep it stable and secure when resting on a flat surface. Those rubber 
feet should be removed with pliers before wall mounting the HomeBase.

1. Secure screws to the bottom panel by sliding them into the available slots.

2. Attach the bottom panel to the mounting bracket matching the holes to the secured screws.

3. Fasten the screws to secure the HomeBase to the mounting bracket.

4. Turn the secured HomeBase right side up.

5. Using the appropriate screws, secure the mounting bracket to the wall or vertical surface as shown.
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Dolphin QuadCharger

Overview

The Dolphin QuadCharger is a four-slot charging station that can charge a Li-ion battery in less than four hours. The fourth slot 
features a battery analyzer that completely resets and re-calibrates a battery and displays its resulting capacity.

The QuadCharger is compatible with the Li-ion batteries that power Dolphin 7850 terminals.

Intelligent Battery Charging
Each charging slot works independently of the other three. 

As battery packs charge, the charging circuitry follows the two-step charging process (CC-CV) that is recommended for Li-Ion 
batteries. The process monitors changes in temperature, current, and voltage. The charger also resets and calibrates battery 
pack data to accurately show battery status on the Dolphin display.

Use only the peripherals, power cables, and power adapters from Hand Held Products. Use of peripherals, cables, or power 
adapters not sold/manufactured by Hand Held Products will void the warranty and may damage the terminal. 
Use only the Li-ion battery packs provided by Hand Held Products. The use of any battery pack not sold/manufactured by Hand 
Held Products in a Dolphin terminal will void your warranty and may result in damage to the Dolphin terminal or battery.

Front Panel 

Charging Slots

The QuadCharger contains four charging slots. Each slot holds one battery. When a battery is placed in a slot, it 
immediately begins charging.   

Charge/Analyze Slot

This is the fourth slot and the only one that can be used to analyze a battery. When a battery is placed in this slot, 
it begins charging just as it does in the other three slots. However, if you press the ANALYZE button, it runs the 
battery in this slot through the complete Analyze cycle. For more information, see Using the Battery Analyzer on 
page 11-4.

Battery Capacity Indicator LEDs

These LEDs give a readout of the remaining battery capacity after it has run through a complete analyze cycle. For 
more information, see Battery Capacity Indicator LEDs on page 11-1.

!
!

Battery Capacity 
Indicator LEDs

Status LEDs

Charge/Analyze Slot

Analyze Button

Charging SlotsCharging Slots–with batteries

Charge/Analyze LED
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Analyze Button

Press this button to start a battery analyze cycle; see Using the Battery Analyzer on page 11-4.

Status LEDs

A status LED is located above each of the four battery slots. The color of the LED indicates the charge status of the 
batteries in its slot.

Green The battery in the slot has completed its charge cycle and is ready to use.
Orange The battery in the slot is being charged at a maximum charge rate.
Red The battery in the slot encountered an error during the most recent charge cycle.

Back Panel

Power Supply Connector

Use this connector to attach the power supply to the QuadCharger. 
The universal power supply accepts input voltages between 90-265 volts.

Power Switch

Toggle the power switch to turn the QuadCharger on and off. 

Inserting and Removing Battery Packs 

To insert a battery pack, place the end of the battery without the locking tab into the bottom of the charging pocket and snap the 
battery into place with a hinging motion. The Status LED for that particular slot lights orange when the battery has been properly 
inserted. To remove a battery pack, push the locking tab down and pull the battery out from the charging slot with a hinging 
motion.

Power Switch Power Supply Connector
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Supplying Power to the QuadCharger

Use the power adapter cable that comes with the QuadCharger so that the input voltage is adjusted appropriately.

1. Locate the AC power adapter cable and plug it into the power source. 

2. Connect the power cable to the power adapter.

3. Connect the power cable to the supply connector on the back of the QuadCharger. 

4. Press the power switch to the ON position.
The power LED lights green, and the charger performs a self-diagnostic test that lasts approximately five seconds.

Charging Batteries in the QuadCharger

For best results, battery packs should be at room temperature before recharging them because temperature impacts charging. 
The recommended temperature range is 50° to 95° F (10° to 35° C). 

1. Supply the QuadCharger with power and turn the power switch on.

2. Insert batteries into the appropriate slots. The Status LED for each slot turns orange to indicate that the battery has begun a 
charge cycle.

3. When the Status LED turns green, the battery in the slot has completed charging.

Recommendations for Storing Batteries

To maintain top performance from batteries, follow these storage guidelines:

• Avoid storing batteries outside of the specified temperature range of -4° to 104° F (-20° to 40°C) or in extremely high humidity.
• For prolonged storage, do not keep batteries stored in a charger that is connected to a power source. 
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Using the Battery Analyzer 

The battery analyzer is the fourth slot of the ChargeBase, labeled CHARGE/ANALYZE. This slot runs an Analyze cycle on the 
battery placed in it, which helps you monitor battery capacity over time. 

Analyze Button

The Analyze cycle is initiated when a battery is placed in the Charge/Analyze slot and the Analyze button is pressed. In an 
Analyze cycle, batteries are completely discharged, then recharged to capacity. The battery is completely reset and re-calibrated. 

The amount of time required for a battery to complete the Analyze cycle depends on initial state of the battery’s charge. Minimum 
time is 8 hours, maximum time is 12 hours.

Battery Capacity Indicator LEDs

These LEDs display the charge capacity of the battery at the end of the Analyze cycle. Battery capacity is displayed as a 
percentage of measured capacity/rated capacity where each LED equals 10% battery capacity. At the end of the Analyze cycle, 
these LEDs display the maximum charge level the battery can now hold.

Status LED

The Charge/Analyze slot also contains a standard status LED in the upper, left corner of the slot. When this slot is used for regular 
charging, this LED operates in the usual manner; see Status LEDs on page 11-2.

When this slot is being used to analyze a battery, its status LED functions as follows:

Solid Green The battery has completed the Analyze cycle. 

Flashing Orange The battery is currently being analyzed. 

Solid Red The QuadCharger encountered an error during the Analyze cycle.

To Analyze a Battery
1. Insert the battery into the Charge/Analyze slot (the fourth).

2. Press the Analyze Button (page 11-1). The Status LED flashes orange to indicate that the analyzing cycle has begun.

3. Upon completion of the Analyze cycle, the Status LED lights solid green, and the Battery Capacity Indicator LEDs display 
the battery’s capacity.

The QuadCharger is accumulating battery pack information during the entire Analyze cycle. Do NOT remove the battery until the 
cycle has been completed. !
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Bottom Panel

Mounting the QuadCharger

The QuadCharger should be on a dry, stable surface. To easily adapt the QuadCharger to your environment, it can be mounted 
on a flat, horizontal surface such as a desktop or workbench, or a flat, vertical surface such as a wall. 

When choosing a location, always bear in mind that 

• the mounting location must allow users easy access to power switch and power connector.
• the QuadCharger should be oriented so that users can easily insert and remove battery packs and read the labels, especially 

for the Battery Analyzer.

Using the DIN Rail
Most Dolphin peripherals have a DIN Rail (7.5 high X 35 wide mm) slot on the bottom panel to enable secure mounting. 

To mount the QuadCharger, you slide the DIN Rail into the slot on the bottom panel. Then, using the appropriate nuts and bolts, 
secure the DIN rail to the desk or wall.        

REV.

MFG.
WK/YRITEM #

S/N #

7850-QCE
SC000001

Tested to Comply With FCC Standards
This Class B Digital apparatus complies with 

FOR HOME OR OFFICE USE

Canadian ICES-003. Cet appariel numerique de la
Classe B est conforme a la norme NMB-003 du Canada.

Hand Held Products, Inc.
www.handheld.comN10410

NO USER SERVICEABLE PARTS.
OPENING VOIDS WARRANTY. USE AUTHORIZED
HAND HELD PRODUCTS, INC BATTERY PACK
ONLY. OTHER TYPES OF BATTERIES MAY BURST 
CAUSING INJURY TO PERSONS AND DAMAGE. 
DO NOT CHARGE ALKALINE BATTERIES.
INDOOR USE ONLY.
NICHT IM FRIEN BENUTZEN. 
NE PAS UTILISER a L’EXTERIEUR.

INPUT: 12 VDC @ 3A
OUTPUT: 8.4 VDC @ 0.8A (4)
FOR 7.4 V Li-Ion BATTERIES

TMQuadCharger

12V DC IN

DIN Rail 
Slot
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Troubleshooting

If you encounter problems with your QuadCharger, refer to chart below for possible solutions. If problems persist, please contact 
Limited Warranty (see page 13-3). 

Problem Issue

The Status LED does not come on 
when I insert a battery pack into the 
QuadCharger.

Check the power connections on the QuadCharger; make sure the POWER 
switch is ON and the battery pack is properly seated.

The Status LED lights red during 
charging.

Try to charge the battery in one of the other charging slots. If the Status 
LED lights red again, then the problem is associated with the battery pack.

The Status LED lights red and stays on 
without a battery in the charging slot.

An error occurred during the self-diagnostic test for that particular charging 
pocket. Call Hand Held Products Product Service and request an RMA. 

For additional warranty and return information, see Customer Support and 
Warranty on page 13-1.



Dolphin® 7850 Series User’s Guide–
Preliminary

Rev (b)
5/15/2007

11 - 7

Dolphin QuadCharger Technical Specifications

Structural

Dimensions 11.7 in. long X 5.2 in. wide X 1.5 in. high (29.7 X 13.2 X 3.8 cm.)

Weight 18 oz. (510g)

Material Case:  Polycarbonate ABS blend

Color Blue/Gray

Mounting Use DIN rail slide to mount to a desktop or wall

Capacity Supports 1 to 4 batteries

Environmental

Operating Temperature 14° to 122°F (-10° to 50°C)

Storage Temperature -4° to 158°F (-20° to 70°C)

Charge 32° to 113°F (0° to 45°C)

Electrical Static Discharge 8 KVA immunity on all surfaces

Humidity 90% relative humidity (non-condensing)

Power Supply

Input (Universal) 90-265V, 47-63Hz 

Output 12 Volts DC, 3 A

Input Connection 2 Position IEC 320-C8

Charging 

Standard Charge Completes 100% charge in four hours

Status LED See Status LEDs on page 11-2.

Battery Analyzer See Using the Battery Analyzer on page 11-4.

Agency Approvals

Power Supply UL listed (UL 1950), TUV licensed (EN60 950STD)
Power Supply compliant to FCC part 15 Class B 

Charging CE Marking (EMC); CISPR Pub 22, FCC Part 15 Class B

Fire Retardant UL 94-VO
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Cable Features

In addition to the hardware peripherals, the Dolphin 7850 Series offers several cables you can use with the terminal depending 
on what the needs of your work environment. 

Intelligent Battery Charging

Dolphin terminals, peripherals, and cables are designed with an intelligent battery charging system that protects the battery from 
being damaged by overcharging. When a battery pack is fully charged, the charge process automatically switches to a trickle 
charge that maintains the battery at full capacity. As a result, Dolphin terminals may be connected to Dolphin cables indefinitely.

Voltage

All Dolphin power cables contain a power adapter that converts the voltage from the power source to 9.5 volts DC, which is the 
maximum voltage the terminal can receive. 

Cables

There are several cables in the Dolphin 7850 Series.

Use only the peripherals, power cables, and power adapters from Hand Held Products. Use of peripherals, cables, or power 
adapters not sold/manufactured by Hand Held Products will void the warranty and may damage the terminal.

Cable Description For more information, see…

Dolphin Power Cable Charge-only cable that plugs into the DC Power 
Jack (see page 3-4) on the bottom of the pistol-
grip handle.

Using the Dolphin Power Cable on 
page 12-2

Dolphin Mobile Charger Charge-only cable that connects the terminal to a 
vehicle power outlet.

Using the Dolphin Mobile Charger on 
page 12-3

Dolphin Charge/Comm 
Cable

Charge/Communication cable that connects the 
terminal to an external power source and a host 
workstation, enabling you to power the terminal, 
charge the batteries, and transfer data at the same 
time.

Using the Dolphin Charge/Comm 
Cable on page 12-4

!
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Using the Dolphin Power Cable

The Dolphin Power Cable connects the terminal to an external power source via the DC jack on the bottom panel of the pistol-
grip handle. 

The Dolphin Power Cable contains a power adapter that converts the voltage from the power source to 9.5 volts DC, which is 
the maximum voltage the terminal can receive.

Using the Dolphin Power Cable
1. Set the terminal down on its rubber bumpers; see Rubber Bumpers on page 3-7.

2. Pull back the flap of the DC power jack and plug the power cable into the jack.

3. Plug the power adapter into a standard power outlet. 

4. The terminal switches to external power and the main battery begins charging. The terminal is ready for use.

DC Power Jack

(Pull back the rubber flap to gain 
access to the power jack.)
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Using the Dolphin Mobile Charger

The Dolphin Mobile Charger connects the terminal to a vehicle power source. This cable powers the terminal and charges the 
main battery pack.

Terminal Connector

The terminal connector connects the communication cable to the mechanical 
connector (see Mechanical Connector on page 3-8) on the terminal. The pins 
in this connector work only with the mechanical connector on the terminal.

Jackscrews

The jackscrews secure the terminal connector to the mechanical connector 
on the terminal. Once the terminal connector is plugged into the mechanical 
connector on the bottom panel of the terminal, turn both jackscrews to the 
right to secure the connection. 

Vehicle Power Adapter

The vehicle power adapter plugs into a standard vehicle power source and 
converts voltage to the 9.5 volts DC required by the terminal.

Using the Dolphin Mobile Charger Inside a Vehicle
Using the Dolphin Mobile Charger in combination with the Dolphin Mobile Mount powers and secures the terminal inside a 
vehicle. 

1. Insert the terminal into the Mobile Mount.

2. Install the Mobile Mount inside the vehicle.

3. Plug the Terminal Connector (see page 12-3) of the Dolphin Mobile Charger into the mechanical connector on the bottom 
panel of the terminal.

4. Tighten the Jackscrews (see page 12-3).

5. Plug the Vehicle Power Adapter (see page 12-3) into the vehicle power outlet.

Note: Dolphin terminals contain an intelligent battery charging system that monitors the charging of the battery pack to protect 
the battery from damage by overcharging if left connected to a charging peripheral indefinitely. 

Terminal 
Connector

Jackscrews

Vehicle 
Power 
Adapter
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Using the Dolphin Charge/Comm Cable

The Dolphin Charge/Comm cable charges the Dolphin terminal and communicates with a host workstation. There are three 
connectors: one connects the terminal to an external power source, another to the host workstation, and another to the terminal 
itself. 

The charge/comm cable is actually two cables: a power cable and a communication cable.The communication cable is shown 
below. 

Communication Connector

The communication connector connects the terminal to a host device via USB (v1.1 or higher) or RS-232; USB is 
shown above. Plug this connector directly into a host workstation, then establish ActiveSync Communication (see 
page 12-5). 

The USB plug has four pins and fits into standard desktop computers and laptops.

Ferrite Bead

This is a Urite ferrite bead.

Jackscrews

The jackscrews secure the terminal connector to the mechanical connector on the terminal. Once the terminal 
connector is plugged into the mechanical connector on the bottom panel of the terminal, turn both jackscrews to the 
right to secure the connection. 

Power Cable Connector

The power cable connector connects the charge cable to the power cable. The power cable powers the terminal 
and charges the main battery pack.

The power adapter on the power cable is available in US, UK, and EMEA versions. All version convert the voltage 
from the power source to 9.5 volts DC, which is the maximum voltage the terminal can receive.

Terminal Connector

The terminal connector connects the communication cable to the Mechanical Connector (see page 3-8) on the 
bottom panel of the terminal. The pins in the terminal connector work only with the mechanical connector on the 
terminal.

After connecting the pins, secure the cable to the terminal by turning both jackscrews to the right.

Ferrite BeadJackscrews

Power Cable 
Connector

Terminal 
Connector

Communication 
Connector



Dolphin® 7850 Series User’s Guide–
Preliminary

Rev (b)
5/15/2007

12 - 5

Using the Dolphin Charge/Comm Cable
1. Plug the cable’s terminal connector into the mechanical connector on the bottom panel of the terminal.

2. Tighten the jackscrews.

3. Plug the power cable connector into the power cable.

4. Plug the power adapter on the power cable into a standard power outlet.

5. Plug the communication connector into the host workstation.

6. Establish the ActiveSync Communication (see page 12-5).

ActiveSync Communication
After the terminal is connected to a power source and the host workstation, you need to set up both the terminal and the host 
workstation for ActiveSync communication. 

Setting up ActiveSync for the charge/comm cable is the same as for the HomeBase, which also has a USB and an RS-232 
version. For details, see Using ActiveSync on page 7-3.

Default ActiveSync Communication Values

The default workstation synchronization value for USB communication is ‘USB Connection.

The default workstation synchronization value for RS-232 communication is ‘115200 Default.
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Technical Assistance

If you need assistance installing or troubleshooting, please call your Distributor or the nearest Hand Held Products technical 
support office:

North America/Canada

Telephone:  (800) 782-4263
Fax number:  (315) 554-6705
E-mail:  natechsupport@handheld.com

Latin America

Telephone: (803) 835-8000
Telephone: (800) 782-4263
E-mail:  latechsupport@handheld.com

Brazil

Telephone: +55 (21) 2178-0500
Fax:  +55 (21) 2178-0505
E-mail:  brsuporte@handheld.com

Mexico

Telephone: (803) 835-8000
E-mail:  latechsupport@handheld.com

Europe, Middle East, and Africa

Telephone:  +31 (0) 40 7999 393
Fax:  +31 (0) 40 2425 672
E-mail:  eurosupport@handheld.com

Asia Pacific

Telephone - Hong Kong: +852-3188-3485 or  2511-3050
Telephone - China:  +86 21 6361 3818    
E-mail:  aptechsupport@handheld.com

Japan

Telephone:  +813 5770-6312
E-mail:  aptechsupport@handheld.com

Online Technical Assistance
You can also access technical assistance online at www.handheld.com.

For Further Information
To download the full User’s Guide for these products, visit our website at www.handheld.com.

http://www.handheld.com/Site.aspx/na/en/home/
http://www.handheld.com
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Product Service and Repair

Hand Held Products provides service for all its products through service centers throughout the world.  To obtain warranty or 
non-warranty service, return the unit to Hand Held Products (postage paid) with a copy of the dated purchase record attached.  
Contact the appropriate location below to obtain a Return Material Authorization number (RMA #) before returning the product.

North America

Telephone:  (800) 782-4263
Fax:  (803) 835-8012
E-mail:  naservice@handheld.com

Latin America

Telephone:  (803) 835-8000 
Telephone:  (800) 782-4263
Fax:  (239) 263-9689
E-mail: laservice@handheld.com

Brazil

Telephone:  +55 (21) 2178-0500
Fax:  +55 (21) 2178-0505
E-mail:  brservice@handheld.com

Mexico

Telephone:  +52 (55) 5203-2100
Fax:  +52 (55) 5531-3672
E-mail:  mxservice@handheld.com

Europe, Middle East, and Africa

Telephone: +31 (0) 40 2901 633
Fax:  +31 (0) 40 2901 631
E-mail:  euservice@handheld.com

Asia Pacific

Telephone:  +852-2511-3050 
Fax:  +852-2511-3557
E-mail:  apservice@handheld.com

Japan

Telephone:  +813-5770-6312 
Fax:  +813-5770-6313 
E-mail:  apservice@handheld.com

Online Product Service and Repair Assistance
You can also access product service and repair assistance online at www.handheld.com.

http://www.handheld.com/Site.aspx/na/en/home/
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Limited Warranty

Hand Held Products, Inc. ("Hand Held Products") warrants its products to be free from defects in materials and workmanship and 
to conform to Hand Held Products’ published specifications applicable to the products purchased at the time of shipment. This 
warranty does not cover any Hand Held Products product which is (i) improperly installed or used; (ii) damaged by accident or 
negligence, including failure to follow the proper maintenance, service, and cleaning schedule; or (iii) damaged as a result of (A) 
modification or alteration by the purchaser or other party, (B) excessive voltage or current supplied to or drawn from the interface 
connections, (C) static electricity or electro-static discharge, (D) operation under conditions beyond the specified operating 
parameters, or (E) repair or service of the product by anyone other than Hand Held Products or its authorized representatives.

This warranty shall extend from the time of shipment for the duration published by Hand Held Products for the product at the time 
of purchase ("Warranty Period"). Any defective product must be returned (at purchaser’s expense) during the Warranty Period 
to Hand Held Products’ factory or authorized service center for inspection. No product will be accepted by Hand Held Products 
without a Return Materials Authorization, which may be obtained by contacting Hand Held Products. In the event that the product 
is returned to Hand Held Products or its authorized service center within the Warranty Period and Hand Held Products determines 
to its satisfaction that the product is defective due to defects in materials or workmanship, Hand Held Products, at its sole option, 
will either repair or replace the product without charge, except for return shipping to Hand Held Products.

EXCEPT AS MAY BE OTHERWISE PROVIDED BY APPLICABLE LAW, THE FOREGOING WARRANTY IS IN LIEU OF ALL 
OTHER COVENANTS OR WARRANTIES, EITHER EXPRESSED OR IMPLIED, ORAL OR WRITTEN, INCLUDING, WITHOUT 
LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

HAND HELD PRODUCTS’ RESPONSIBILITY AND PURCHASER’S EXCLUSIVE REMEDY UNDER THIS WARRANTY IS 
LIMITED TO THE REPAIR OR REPLACEMENT OF THE DEFECTIVE PRODUCT. IN NO EVENT SHALL HAND HELD 
PRODUCTS BE LIABLE FOR INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, AND, IN NO EVENT, SHALL ANY 
LIABILITY OF HAND HELD PRODUCTS ARISING IN CONNECTION WITH ANY PRODUCT SOLD HEREUNDER (WHETHER 
SUCH LIABILITY ARISES FROM A CLAIM BASED ON CONTRACT, WARRANTY, TORT, OR OTHERWISE) EXCEED THE 
ACTUAL AMOUNT PAID TO HAND HELD PRODUCTS FOR THE PRODUCT. THESE LIMITATIONS ON LIABILITY SHALL 
REMAIN IN FULL FORCE AND EFFECT EVEN WHEN HAND HELD PRODUCTS MAY HAVE BEEN ADVISED OF THE 
POSSIBILITY OF SUCH INJURIES, LOSSES, OR DAMAGES. SOME STATES, PROVINCES, OR COUNTRIES DO NOT 
ALLOW THE EXCLUSION OR LIMITATIONS OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE 
LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

All provisions of this Limited Warranty are separate and severable, which means that if any provision is held invalid and 
unenforceable, such determination shall not affect the validity of enforceability of the other provisions hereof.

Hand Held Products extends these warranties only to the first end-users of the products. These warranties are non-transferable.

The limited duration of the warranty for the Dolphin 7850 Series is as follows:

• Terminals with an integrated imager are covered by a two-year limited warranty.
• Batteries are covered by a one-year limited warranty. 
• Dolphin HomeBase, Dolphin QuadCharger, and Dolphin Mobile Charger are covered by a one-year limited warranty. 

Use of any battery not sold/manufactured by Hand Held Products may damage the terminal and/or the battery and will void the 
warranty. Batteries returned to Hand Held Products in a reduced state may or may not be replaced under this warranty. Battery 
life will be greatly increased when following the battery instructions in the Dolphin 7850 Series User’s Guide.

Use of any peripheral not manufactured/sold by Hand Held Products will void the warranty. This includes but is not limited to: 
cables, power supplies, cradles, and docking stations.

Use only power adapters approved for use by Hand Held Products. Failure to do so may result in improper operation or damage 
to the unit and will void the warranty.

How to Extend Your Warranty
Hand Held Products offers a variety of service plans on our hardware products. These agreements offer continued coverage for 
your equipment after the initial warranty expires. For more information, contact your Sales Representative, Customer Account 
Representative, or Product Service Marketing Manager from Hand Held Products, or your Authorized Reseller. 
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